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Introducción 

 

 

 

La presente tesis es el resultado de un proyecto de investigación y producción artística, 

que ha tenido como propósito la intervención artística contemporánea de un sitio 

específico en el espacio público de Taxco. Esta propuesta es producción de los Talleres de 

Experimentación Plástica (Arte Urbano) que impartió el Mtro. Gerardo Garcia-Luna 

Martínez, de las asignaturas Teorías de Análisis Visual que dicto el Dr. José Eugenio 

Garbuno Aviña y del curso de Tema Selecto: Arte, Diseño y Procesos del Mtro. Luis Ernesto 

Serrano Figueroa todas ellas de la Maestría en Artes Visuales de la Escuela Nacional de 

Artes Plásticas, en cada uno de estos espacios se dio la reflexión profunda de los diversos 

componentes que conforman este trabajo. Por tal motivo este escrito está dividido en dos 

partes: la primera se refiere a las investigaciones que contextualizan y motivan la 

propuesta artística, en la segunda parte se analizan los diferentes productos y procesos 

que resultaron del proyecto de arte contemporáneo Tlachtli-Pelota: Proyecto de arte 

contemporáneo en el espacio público de Taxco. 

Uno de los pretextos para iniciar este proyecto artístico fueron los comentarios 

que escuchaba en los círculos culturales de Taxco, que rezaban incesantemente sobre la 

imposibilidad de hacer arte contemporáneo en los espacios públicos de esta ciudad 

platera, debido al celo con el cual sus habitantes y autoridades conservan su patrimonio 

urbano colonial. Sin embargo, estos dichos no concordaban con lo que yo veía en las 

calles. Si bien Taxco es un Pueblo Mágico porque conserva muchos valores artísticos y 

urbanos del siglo XVI, está invadido por la cultura contemporánea la gente viste a la moda, 

usa celulares y reproductores de música mp3, sus jóvenes hablan de twitter y facebook, 

sus calles están llenos de automóviles como otras ciudades, la mayoría de sus 

edificaciones son como las de cualquier colonia marginal de México (grises), a diferencia 

de como se presenta al turismo con sus calles principales maquilladas como en antaño, 

utilizando el arte contemporáneo para simular tejas, encalados y techos de viguería, ésto 

lo analizo en el primer capítulo donde asistirá el lector a un viaje del mítico Taxco a la 

hiperrealidad de taXcoLandiA.com. 

En el segundo capítulo describo algunas características del sitio específico donde se 

instaló la obra, la Ex Hacienda del Chorrillo. Hablaré sobre su historia, su importancia 

cultural para los taxqueños, y sobre los signos que retomé para la propuesta. También 

comentaré sobre el olvido de un elemento esencial de la vida orgánica y simbólica de los 
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taxqueños, el agua, que era el motor de la vida económica y urbana de Taxco, y por el cual 

esta hacienda se llamaba Cantarranas, debido a la gran cantidad de agua que recibía y que 

formaba un habitat propicio para el desarrollo y reproducción  de estos batracios (ranas), 

no obstante hoy se encuentra reducido el flujo de este vital liquido a un Chorrillo de 

temporal. 

El siguiente capítulo, que cierra la primera parte de este trabajo, y  presenta el 

concurso de modelado virtual Design It: Shelter Competition, organizado por el Museo 

Guggenheim de Nueva York y el programa de diseño asistido por computadora Google 

SketchUp, donde se invita a modelar con dicho software un refugio en cualquier parte del 

mundo, y es gracias a este concurso que motiva la concreción de la propuesta artística. Es 

importante mencionar que las condiciones de dicho concurso son un marco contextual del 

proyecto y de su realización. 

Ahora bien, en la segunda parte analizaremos la realización de la intervención 

“Tlachtli – Pelota: Proyecto de arte contemporáneo en el espacio público de Taxco”, para 

lo cual empleo como guía de estudio la caracterización que hace Francisco Pérez Cortés 

del arte contemporáneo en su libro Lo material y lo inmaterial en el arte‐diseño 

contemporáneo (materiales, objetos y lenguajes virtuales), donde nos plantea este nuevo 

arte como una actividad teórico ‐ práctica de carácter proyectual, que tiene por objetivo la 

elaboración formal y técnica de obras, objetos, imágenes, y espacios que responden 

siempre de manera pertinente, a una necesidad individual o colectiva del hombre, siendo 

una actividad con un alto grado de complejidad, en la que intervienen factores de muy 

diferente tipo y procedencia. 

Universos Virtuales es el primer capítulo de esta segunda parte, y trata sobre los 

valores artísticos de una serie de productos y subproductos artísticos obtenidos del 

modelado virtual del proyecto, que presente para el concurso Design It: Shelter 

Competition, antes mencionado, se habla sobre el diseño asistido por computadora como 

técnica artística, sobre los modelos virtuales y sus cualidades para compartir información, 

y finalmente se tratan las capacidades comunicativas de las a las fotografías y videos 

digitales que generan estas herramientas informáticas actuales. 

El siguiente capítulo trata sobre los materiales y su dimensión contemporánea, 

desde los materiales artificiales diseñados por la tecnociencia de la química, como son los 

acrílicos y los paneles de tabla concreto donde los plásticos tienen un protagonismo 

fundamental, hasta los materiales naturales como el agua y la madera, son transformados, 

contenidos y conceptualizados gracias a modelos geométricos constructivos, como son los 

solidos geométricos, el ortoedro para la madera (tablas y polines), y una esferoide 

truncada para el agua (estanque), dotándolos de una caracterización contemporánea. 
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Finalmente en el último capítulo se analiza la propuesta como objeto de la mirada, 

de uso y de apropiación, esto describe unas de las características fundamentales de la 

propuesta de Francisco Pérez, que el arte contemporáneo es multinivel, pluridimensional, 

polimórfico, policéntrico, autorregulador y polisistémico, es decir, que la elaboración e 

interpretación de una obra actual se describe como un complejo de conocimientos, 

técnicas, materiales, imágenes, objetos, intenciones, procesos, puntos de vista, entre 

otras muchas cosas más, de las cuales iremos comentando a través de esta tesis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



6 
 

 

 

 

 

 

 

 

 

 

 

 

 Primera Parte: Contextos y motivos 

 

 

 

 

 

 

 

 

 

 

 



7 
 

1. Del mítico Taxco a taXcoLandiA.com 

 

 

 

 

Hoy en día, la abstracción ya no es la del mapa, la del doble, la del espejo o la del concepto. 

La simulación no corresponde a un territorio, a una referencia, a una sustancia,  

Sino que es la generación por los modelos de algo real sin origen ni realidad: lo hiperreal.  

El territorio ya no precede al mapa ni le sobrevive.  

En adelante será el mapa el que preceda al territorio. 

Baudrillar, 1978. 

 

El origen de esta propuesta se inicia con mi llegada a trabajar como docente en la Escuela 

Nacional de Artes Plásticas campus Taxco, esta ciudad-pueblo llena de historias, leyendas 

y mitos, donde se forjo con las artesanías en plata algo de la identidad mexicana, donde se 

habla de la presencia de la llorona como algo familiar, o donde las anécdotas de mineros 

desaparecidos mezclan la vida y la muerte como una continuidad y no como una ruptura. 

Así es, existe un Taxco mítico construido a través de las centurias que ya no tiene lugar en 

el mundo contemporáneo como algo real, solo queda de él su hiperrealidad, “anulada su 

ilusión nos sumergimos en el simulacro, apariencias que envuelven el mundo en 

imágenes”1. El espacio urbano de la ciudad de Taxco se encuentra hoy intervenido por los 

simulacros del arte contemporáneo, la ciudad ya no es un espacio público, hoy día es una 

interface que nos permite consumir su propia imagen. Siendo ésta sobreposición de 

artificialidad contemporánea sobre el Taxco colonial la que analizó en este capítulo, y a 

partir de los resultados de dichas pesquisas se desarrollan algunos conceptos en la 

propuesta artística. 

                                                           
1
 Baudrillard, Jeán (1978). Cultura y simulacro. Barcelona: Kairos. 
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Los invito a viajar desde ese Taxco mítico al mundo virtual de taXcoLandiA, 

colóquense su casco de inmersión para entrar en este mundo virtual. Comencemos por la 

puerta de entrada, imaginemos que vamos subiendo la sierra por un camino polvoso y 

donde nuestro reluciente Ford T no se siente muy bien, viene refunfuñando ya hace dos 

horas, y finalmente hemos llegado a nuestro destino. 

Tasco nos recibe con una fuente, en el sitio llamado Memetla, a la orilla del camino 

que ladea la montaña del Huisteco... Llegando a ella, vemos todo el panorama de 

Tasco. Felices vosotros que habéis llegado a esta fuente: estáis en Tasco.2 

 

 

Imagen 1: Ilustración de Francisco Díaz de León, 1928 

 

                                                           
2
 Toussaint, Manuel (1956). Tasco: guía de emociones. México: Fondo de Cultura Económica, p.p.5. 
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Así era la llegada a Taxco antes de que el mundo moderno lo descubriera, hoy día 

es un poco diferente, primero llegamos en nuestros “automóviles hibridos” de Honda a 

toda velocidad por la moderna autopista3, a 6 kilómetros de la última caseta de peaje 

podemos ver a la ciudad de Taxco que nos recibe con sendas banderolas y reguiletes que 

nos recuerdan un parque de diversiones, más que una ciudad con rico patrimonio colonial 

arquitectónico y urbanístico, que le han hecho ser merecedor a formar parte del selecto 

grupo de lugares denominados “Pueblos Mágicos”. 

 

Imagen 2: Entrada a Taxco por el sur. 

 Realizando un análisis de los objetos  que encontramos sobre la carretera por la 

entrada norte (ver Imagen 2), nos percatamos que el mobiliario urbano se caracteriza por 

ser contemporáneo debido a sus materiales sintéticos y su complejidad 

multidimensional4. Adosado al puente peatonal observamos un gran espectacular 

realizado con materiales sintéticos y colores vivos, lo cual nos comienza a mostrar el 

                                                           
3
 Esta carretera se la debemos a las gestiones de los “Amigos de Taxco” que lucharon para lograr que el 

proyecto de la carretera Amacuzac-Acapulco se modificara y pasara por Taxco. Babini, Andrea (2005). Taxco 
de Alarcón: evolución de una ciudad minera. Análisis del espacio urbano y tipologías arquitectónicas. 
Chilpancingo: Universidad Autónoma de Guerrero, p.p.95. 
4
 Pérez Cortés, Francisco (2003). Lo material y lo inmaterial en el arte-diseño contemporáneo (materiales, 

objetos y lenguajes virtuales). México: Universidad Autónoma Metropolitana, p.p. 98. 
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desfase entre la reglamentación y las prácticas reales, al estar prohibido por el reglamento 

de construcción vigente en Taxco de Alarcón5 los materiales plásticos, donde el artículo 3 

menciona: Queda prohibido el uso de plásticos… en exteriores.  También encontramos una 

serie de postes con banderolas que se repiten con frecuencia matemática sobre la 

carretera y que contienen un modelo aplicado en ambas caras, dándole una doble 

dimensión en ambos sentidos del flujo vehicular, este modelo contiene geometrías 

espectaculares, y la gráfica nos presenta la imagen corporativa de la marca “Pueblos 

Mágicos”, siendo la estandarización visual una característica de la contemporaneidad.  

 

Imagen 3: Entrada a Taxco por el norte. 

 

 En la entrada norte podemos observar esta caseta de información turística (ver 

imagen 3), contiene un reguilete animado que gira alrededor de su eje central, también 

realizado con materiales sintéticos y complementado con maquinas revolucionadas para 

simular el efecto del aire sobre la imagen de este juguete tradicional mexicano. Lo cual 

definitivamente nos comienza a presentar a Taxco como una obra de arte-diseño 

                                                           
5
 Junta de conservación de la ciudad de Taxco de Alarcón, Guerrero (2007). Ley N° 174 de Conservación y 

Vigilancia de la Ciudad de Taxco de Alarcón. Guerrero. Taxco de Alarcón, Guerrero. 
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contemporáneo y nos aleja de ese Taxco mítico y fantástico que descubrieron las 

generaciones posteriores a la revolución mexicana: 

Desde las primeras calles nuestro asombro se exalta: ¿qué país exploramos?, no 

son estas calles torcidas y soleadas, con teja rojísimas en los techos, con verdes 

macetas en sus ventanas, con corredores abiertos al paisaje las de algún pueblo de 

Andalucía, la hechicera?. Pero no: esta placita gris con esa gran construcción que la 

cierra por un lado, ¿no parece la de alguna ciudad castellana: Avila, Toledo, 

Segovia?. Estamos en México, la tradición ha sabido conservar el carácter, el 

coloniaje que a esta población diera Borda y así se realizó este milagro de 

serenidad, de reposo, de belleza, de arte, de amor: Tasco.6 

 

 

Imagen 4: Taxco antes de la modernidad (www.taxco-pueblomagico.com) 

 

 Así vieron el Taxco mítico los primeros hombres modernos que llegaron como 

turistas a este pueblo, lo observaron a través de la mirada de una máquina fotográfica, y 

como designio programado encontramos en este hecho la semilla de lo que es hoy Taxco 

                                                           
6
 Toussaint (1967), p.p.6. 
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un lugar lleno de maquinas automotrices que arrinconan a los lugareños y turistas, como 

vemos en la siguiente imagen, que fue tomada en el interior de un trasporte público en la 

misma calle de la foto anterior, un poco más adelante frente al Palacio Municipal. (ver 

Imagen 5).              

 

Imagen 5: Tráfico en el Taxco actual. 

No obstante, este nuevo Taxco, no es milagro de serenidad, es como cualquier 

ciudad del mundo, una entropía urbana. Lo cual me recuerda el chiste que escuche en una 

tertulia ofrecida por el Museo Virreinal de Taxco con motivo de una exposición de 

fotografías “híbridas”; el cual muestra la tendencia actual de la pérdida de identidad 

urbana vernácula a favor de la cultura contemporánea motorizada: 

“¿Sabes de donde viene la palabra Taxco?, inocentemente expuse sus orígenes 

etimológicos de la palabra Tlachco, y el cuenta chistes me interrumpió diciendo: 

¡NO!, estas mal, viene de Taxi y Combi” (anónimo) 

 Hasta el momento hemos solamente pasado por el acceso de entrada a 

taXcoLandiA, sin embargo tenemos que toparnos con el mapa del lugar, es decir, con el 

modelo Taxco. Lo encontramos en la página www.taxco-pueblomagico.com, donde se 

resume este parque de atractivos turísticos y artesanales en una revista electrónica, en su 

contenido se formaliza el modelo, se encuadra en un espacio referencial específico, se 
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habla de sus fechas importantes, de sus lugares turísticos, y además, es un directorio de 

negocios, acedemos ahí, a “Todo lo que necesita saber de Taxco, Guerrero en un solo sitio” 

(ver Imagen 6 y 7). Lo cual deja de lado los aspectos negativos de Taxco, su gravísimo 

problema de contaminación visual y física del entorno, su escalada de violencia, la perdida 

de autenticidad de la platería por la introducción de materiales y objetos sintéticos. 

 

Imagen 6: Portada de la publicación electrónica 

 

Imagen 7: Contenido de ubicación del modelo 

Para un modelo turístico no es necesario conocer la realidad, solo importa 

exacerbar lo placentero del lugar creando una imagen hiperreal y ocultando lo demás, “No 

se trata ya de imitación ni de reiteración, incluso ni de parodia, sino de una suplantación 

de lo real por los signos de lo real, es decir, de una operación de disuasión de todo proceso 

real por su doble operativo, máquina de índole reproductiva, programática, impecable”7. 

                                                           
7
 Baudrillard (1978), p.p. 7. 
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Así, comienza la interferencia del arte contemporáneo en éste espacio mítico de la 

República Mexicana, trasportando al visitante-turista-consumidor de un espacio vivo a un 

espacio preconcebido por la publicidad, esta operación la vemos en todos y cada uno de 

los lugares de atracción propuestos por el modelo. Podemos verlo en Santa Prisca, joya 

arquitectónica del barroco que guarda esta población (ver Imagen 8), espacio ritual de la 

liturgia católica, donde se vacía de los significados profundos al arte sagrado por medio de 

cada fotografía que toma el profano turista de esta ciudad (ver Imagen 9), duplicando 

hasta el infinito la autenticidad del arte, anulando el aura8 del arte taxqueño, a favor de la 

evidencia tecnológica que testimonia que lo que dice el folleto es “verdad” y como el 

modelo no dice nada, más que es un importante templo estilo barroco, sus fechas de 

construcción, el nombre de su patrocinador y un slogan: “Dios da a Borda, Borda da a 

Dios”, pues solo resta tomar otra foto dándole clik a nuestra máquina fotográfica. 

                     

Imagen 8: Ritual en la Iglesia de Santa Prisca                  Imagen 9: En el exterior fotógrafos-turistas 

El turista ávido de maravillarse de lo bellas y rápidas que son las tomas que realiza 

con su teléfono celular, que integra una cámara digital de 12 megapixeles, va caminando 

por la calle turística por excelencia, Benito Juárez, y hace una infinidad de fotos frente a 

las perspectivas urbanas que ofrece Taxco, para inmediatamente después publicarlas en el 

Facebook o Twitter por medio de su teléfono inteligente, expandiendo así, el modelo 

                                                           
8
 Benjamin, Walter (1989). Discursos Interrumpidos I. Buenos Aires: Taurus. 
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taXcoLandiA, en el espacio natural de la hiperrealidad, la Internet (ver imagen 10). Y 

donde “Cada día cobra una vigencia más irrecusable la necesidad de adueñarse de los 

objetos en la más próxima de las cercanías, en la imagen, más bien en la copia, en la 

reproducción”9. 

 

Imagen 10: Turistas fotografiando las vistas urbanas.  

  

Antes de meternos con mayor detalle en al análisis central de nuestro objeto de 

estudio que son las intervenciones artísticas contemporáneas en el espacio público 

taxqueño, es momento de retroceder en el tiempo, y saber de los orígenes de esta 

tendencia cultural contemporánea que hemos venido describiendo. Preguntarnos ¿si fue 

descubierto o inventado?, tal vez nos aclare porqué un lugar como este, cobijado por  un 

decreto presidencial de protección artística e histórica y lleno de autenticidad por sus 

largos años de olvido, se ha convertido en una escenografía teatral y turística, podemos 

comenzar por una reflexión, de Baudrillard que nos dice: “La etnología rozó la muerte un 

                                                           
9
 Benjamin (1989). 
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día de 1971 en que el gobierno de Filipinas decidió dejar en su medio natural, fuera del 

alcance de los colonos, los turistas y los etnólogos, las pocas docenas de Tasaday recién 

descubiertos en lo más profundo de la jungla donde habían vivido durante ocho siglos sin 

contacto con ningún otro miembro de la especie. La iniciativa de esta decisión partió de los 

mismos antropólogos que veían a los Tasaday descomponerse rápidamente en su 

presencia, como una momia al aire libre”10.  

 

Imagen 11: Ilustración de la visión de Taxco en 1935, donde observamos ese Taxco mítico y a manera de 

presagio vemos del lado superior izquierdo la maquina automotriz arribando a esta cuna de serenidad. 

Esto no fue lo que paso en Taxco, una vez que la moderna carretera Amacuzac-

Acapulco cruzo por Taxco, se dejaron venir personajes de la vida cultural mexicana, que 

por su condición sensitiva de artistas les permitió  experimentar la autenticidad de un 

pueblo colonial perdido en el tiempo, con su trazo urbano orgánico, de “plato roto”, con 

sus casas típicas encaladas y rematadas con techos de teja roja, con sus plazas e iglesias, 

con su topografía, con el agua, y que con la mejor intención quisieron compartir este 

                                                           
10

 Baudrillard (1978), p.p. 16. 



17 
 

símbolo vernáculo de la mexicanidad con el mundo, no obstante con ello comenzó la 

propia anulación del Taxco mítico. 

  

Imagen 12: La generación postrevolucionaria que descubrió a Taxco para el mundo 

 La anterior fotografía (ver Imagen 12) nos muestra de izquierda a derecha, al 

diseñador norteamericano avecindado en Taxco William Spratling, que fundó el estilo de 

joyería moderna taxqueña, mediante una estrategia formal inspirada en motivos 

prehispánicos, enseguida observamos a uno de los protagonistas del movimiento 

muralista nacional David Alfaro Siqueiros, y finalmente al director de cine soviético 

Serguei Eisenstein, y a su camarógrafo Edouard Tisse con quien filmo la película ¡Viva 

México!, que junto con otras películas de la industria mexicana convirtieron estos espacios 

de vida cotidiana provincianos en locaciones cinematográficas. Entre las varias películas 

que se filmaron en Taxco resalta Macario, una película de Roberto Gavaldon, donde se 

ejercita uno de los procedimientos constructivos del arte contemporáneo, el  

desplazamiento11, ya que la película tiene como temática la muerte, y está ambientada en 

la época de la festividad de Día de Muertos, propia de lugares como Mixquic en el Estado 

de México o Patzcuaro en Michoacan por poner dos ejemplos, sin embargo, ésta 

celebración de profundos significados cosmogónicos en el pensamiento azteca es 

desplazada por razones proyectuales a Taxco, donde se descontextualiza para decorar el 

                                                           
11

 Pérez (2003), p.p.59.  
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espacio urbano, reforzando así la imagen identitaria del cine mexicano, no como una 

experiencia simbólica, sino como un signo discursivo. Es decir, si bien estas imágenes de 

festividades populares se producen por medio de rituales antiquísimos, en el cine se 

suprime el ritual y se queda solo con algunos signos seleccionados, como vemos en la 

siguiente imagen (ver Imagen 13), se ponen en escena una serie de imágenes que 

funcionan como ambientación y donde observamos mujeres de negro cargando calaveras, 

cuando las calaveras de azúcar, no se andan transportando en procesión los días de 

muertos, más bien, forman parte del altar de día de muertos, que junto con otros 

elementos recuerdan e invitan al difunto a compartir este día con los vivos. 

  
Imagen 13: Fotograma de Macario. 

 

  

Imagen 14: Publicidad de las Jornadas Alarconianas 2010 

 Así, la tendencia de usar el espacio urbano como escenográfico se observa en 

diferentes eventos culturales de Taxco, como son las Jornadas Alarconianas que tiene 

como lema “Vive la magia del arte en la ciudad teatro”, en la imagen (14) vemos una 
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publicidad de dicho evento, en la ilustración del fondo se muestra un piso empedrado con 

estilo Taxco, piedras irregulares contrastadas en blanco y negro donde se integran siluetas 

de intérpretes de las artes escénicas, a las cuales está dedicado en su gran mayoría este 

festival, con la intención de invitar al publico a estos eventos, donde se concibe el espacio 

público como un espacio escénico y a los ciudadanos como espectadores.  

 

  

Imagen 15: Evento de las Jornadas Alarconianas. 

 

 No obstante, el momento que al parecer 

motiva todas las intervenciones artísticas 

contemporáneas en el espacio público de Taxco 

son las festividades de Semana Santa, fechas 

donde se abarrotan las calles de turistas con 

hambre de documentalistas. Y donde una vez 

más la máquina fotográfica hace de las suyas, 

exacerbando la muerte del aura artística a favor 

de la apariencia de la imagen donde “el valor 

exhibitivo de la imagen comienza a reprimir toda 

la línea del valor cultural”12.            

                        Imagen 16: Penitente en Taxco. www.esmas.com 

                                                           
12

  Benjamin (1989), p.p. 7. 
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 Hasta aquí hemos recorrido algunas de las atracciones de taXcoLandiA pero es 

momento de pararnos y analizar a fondo la imagen urbana de Taxco, para formalizar la 

fuerte tendencia contemporánea de su arte urbano, ya vimos las razones. Ahora veremos 

los objetos que revisten este modelo virtual, para ello tomaremos como guía la tercera 

parte del libro Taxco de Alarcón – Evolución de una antigua ciudad minera: Análisis urbano 

y tipologías arquitectónicas producto de la investigación de doctorado de Andrea Babini, 

académica de la Universidad Autónoma de Guerrero, donde crea un catalogo 

pormenorizado de los modelos taxqueños en los temas de morfología urbana y 

arquitectura, cito a la autora: “La ciudad de Taxco de Alarcón es singular: un modelo de 

ciudad construida en adaptación al medio…”13. Esta guía nos permitirá revisar 

puntualmente los objetos y materiales que le dan forma y sentido a taXcoLandiA. 

 

Imagen 17: Ilustración en el libro de Babini  Imagen 18: Fotografía satelital de Google Earth 

El primer elemento que vamos a revisar son los terrenos y las construcciones, en la 

ilustración del lado izquierdo (ver Imagen 17) vemos lotes y casas de “proporciones 

humanas”14, con formas irregulares y en balance con las zonas verdes, en contraste en las 

fotografía satelital del lado derecho (ver Imagen 18) observamos terrenos y 

construcciones de dimensiones masivas y desproporcionadas respecto a sus áreas verdes, 

no obstante mantienen cierta irregularidad en la lotificación, estos espacios responden a 

necesidades contemporáneas, son equipamientos urbanos como unidades deportivas, 

escuelas, supermercados, centros comerciales, hoteles, hospitales, y centros joyeros; que 

                                                           
13

 Babini  (2005), p.p. 1. 
14

 Babini  (2005), p.p. 171. 
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si bien son actividades siempre presentes en la vida cotidiana, sus soluciones 

arquitectónicas actuales destacan por ser de proporciones monstruosas. Hay que notar 

que estos edificios mantienen ciertas características típicas de la arquitectura vernácula 

taxqueña de las cuales hablaremos más adelante.  

Saliéndonos de los espacios interiores de las construcciones que le dieron esa traza 

particular de “plato roto” a Taxco, nos situamos en sus calles, de las cuales se han escrito 

opiniones bellísimas, para describirlas quien mejor que Manuel Tousssaint: 

“Imposible imaginar seres más caprichosos, más locos que las calles de Tasco. 

Odian la línea recta por su fealdad matemática; detestan la horizontal por su falta 

de espíritu. Aquí en Tasco, las calles avanzan, suben, descienden, tuercen a la 

izquierda, después a la derecha; de pronto se encabritan en una barranca, o se 

arrepienten y regresan al punto de partida…”15   

 

Imagen 19: Calle arrepentida de Taxco, trazas orgánicas con sentido humano.  

[Artes de México (Taxco), Nueva época, Número 5, México, otoño de 1989] 

                                                           
15

 Toussaint (1967), p.p. 80. 
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 En la siguiente fotografía se presenta la primera intervención contemporánea en 

Taxco, la carretera federal Amacuzac-Acapulco, que fue una intervención importantísima 

para el auge de Taxco como centro turístico. Aquí observamos ya la presencia de los 

materiales contemporáneos complejos, que son resultado de la mezcla de varios 

ingredientes, a este suelo se le llama pavimento asfáltico y “está constituido por 90% de 

agrega pétreos gruesos y finos, un 5% de polvo mineral (filler) y otro 5% de ligante 

asfáltico”.16 Lo cual genera una imagen urbana estandarizada, que bien puede encontrarse 

en cualquier ciudad, el piso gris monótono, las banquetas que nunca han existido en el 

urbanismo colonial vernáculo, el pintado superficial de las calles con materiales 

reflejantes, la señalización, la calle no peatonal como en la colonia, es una calle para flujos  

y comunicación. 

 

Imagen 20: Toma de la Av. Plateros carente de identidad Taxqueña 

 

 En contraste se muestra la diversidad de tipologías decorativas de los pisos en 

Taxco, “presentando variados diseños para lo que se usan piedras azules, grises, rosadas y 

negras que contrastan en la superficie. Estos se resuelven por dibujos geométricos que 

                                                           
16

 Padilla, Alejandro. Mezclas Asfálticas. 26 p.p. Consultado el 9 de junio de 2011 en 
upcommons.upc.edu/pfc/bitstream/2099.1/3334/14/34065-14.pdf 



23 
 

recorren la calle longitudinalmente, por gráficos que representan plantas, animales y por 

números que nos recuerdan fechas de cuando fueron construidas algunas de ellas”17.  

   

Imagen 21: Piso típico de las calles de Taxco        Imagen 22: Diseños de pisos según Babini 

En el tema de los pisos existe la tímida presencia de las artes contemporáneas más 

vanguardistas, que son las soluciones de hormigón hidráulico impreso, las cuales se ha 

comenzado a introducir por parte del ayuntamiento, más comúnmente en las calles de 

nueva pavimentación (ver Imagen 23), éstas simulan los tradicionales empedrados, como 

el modelo llamado “empedrado irregular” de la empresa Hormisol (ver Imagen 24).  

 Imagen 23                  Imagen 24 

                                                           
17

 Babini (2005), p.p.172. 
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Ahora  hablaremos de las fachadas, en la siguiente imagen (25) observamos el 

muro de una fachada tradicional, caracterizada como dice el reglamento de construcción 

de la ley 174 de Conservación y Vigilancia de la Ciudad de Taxco, Guerrero de la siguiente 

manera: “Los aplanados exteriores, deberán ser rústicos, encalados, color blanco”18.  

 

Imagen 25: Fotografía de las fachadas del mítico Taxco al inicio del siglo pasado. 

 

Del modelo anterior se nos impone este simulacro de encalado, gracias a la 

tecnociencia química las pinturas acrílicas de color blanco que dan la impresión de esos 

encalados de antaño ya, tan escasos en Taxco (ver Imagen 26). 

 

Imagen  26: Solución de rodapiés y aplanados extremadamente difundida en Taxco 

                                                           
18

 Junta (2007), p.p.13. 
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Aprovechando imagen anterior, hablaremos de los rodapiés que nos dice las bases 

de construcción de la ley 49 de vigilancia y conservación de la ciudad de Taxco: “Los 

rodapiés serán de piedra de recinto, construcción rustica (canto rodado) (Se excluyen el 

cemento, matelinados y piedra artificial)”19, es decir, se prohíben los acabados que 

simulen los acabados tradicionales. Sin embargo vemos en esta fotografía (ver imagen 26) 

como son pintadas las piedras sobre aplanados de cemento, esta solución rudimentaria 

también forma parte de las artes contemporáneas, tienen el sentido de la apariencia, ya 

no importa la realidad solo importa que parezcan, son la presencia del modelo. 

 

Imagen 27: Fachadas donde el acabado exterior está íntimamente ligado con los procesos constructivos 

En otro apartado de la ley 49 habla de que los muros podrán ser de “piedra, adobe, 

tabique, etcétera… se excluye el cemento…”20, ya qué el espíritu de estas leyes tienen en 

mente, como  “El testimonio de nuestra cultura popular, conserva materiales y sistemas 

constructivos regionales de gran adecuación al medio, por lo que constituye un patrimonio 

enorme y de vital importancia, que debe ser rescatado, protegido… y conservado”21. 

                                                           
19

 Babini (2005), p.p. 351. 
20

 Babini (2005), p.p. 351. 
21

 H. Ayuntamiento Municipal de Taxco de Alarcón. Plan de desarrollo municipal. Consultado el 30 de enero 
de 2011 en http://taxco.gob.mx/gobierno/plan-de-desarrollo-municipal. 
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Sin embargo, con la irrupción del Super Che, de proporciones monstruosas y que 

representa un catalogo de soluciones del arte contemporáneo para la ciudad de Taxco, se 

abrió la caja de pandora posmoderna ampliando el imaginario colectivo de los taxqueños, 

motivando la repetición de este ejercicio en toda la ciudad, transformando la imagen 

urbana de la ciudad de una estética profunda fundada en la historia y vida regional que 

simboliza una cultura vernácula como la taxqueña, e imponiendo una estética 

contemporánea fundada en los medios de producción industrializada que estandarizan 

desde los procesos constructivos hasta las apariencias, donde los materiales y objetos son 

solo signos vaciados de significación, son pura apariencia. Algo que prohíbe el reglamento 

de la 174 ley que en su artículo primero que reza así: “Queda estrictamente prohibido el uso 

de concreto aparente en exteriores”22, no obstante esta construcción (ver imagen 28) esta 

forrada toda de tabla concreto, que es una aleación entre cementos y unicel, y donde 

podemos observar una escenografía vertical de Taxco con un sin número de falsas ventanas, 

terrazas y parasoles, pero detrás, en su interior vemos el vacío (ver Imagen 29), 

transformando definitivamente paisaje urbano de Taxco surgido de su adaptación al medio 

topográfico, “… Dada la accidentada topografía del sitio, la traza era quebrada con grandes 

desniveles… que… ofrecían agradables visuales de las techumbres de las casas”23. 

            

Imagen 28 y 29: Super Che de Taxco, pura apariencia. 

                                                           
22

 Junta (2007), p.p. 11. 
23

 Flores, Vicente (2008). “La situación de los centros históricos en México”. En Taxco: La perspectiva urbana. 
Universidad Nacional Autónoma de México, p.p. 34. 
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  Imagen 30: Fonda en Taxco cubierta de lona plástica           Imagen 31: Casa en Taxco con tejados de plástico 

Continuado con lo anterior veremos cómo esta permisibilidad de la introducción 

del arte contemporáneo se ha filtrado en las practicas constructivas de los ciudadanos de  

Taxco, que aplican estas soluciones artificiales por todo lados, soluciones temporales, 

donde vemos una pared de lona plástica (ver imagen 30), o en los innumerables techos de 

plástico que simulan tejados (ver imagen 31), soluciones que el Art. 3 del reglamento de 

construcción norma: “Queda prohibido el uso de plásticos, laminas de cartón o asbesto, 

telas impermeables o semejantes en las cubiertas o acabados exteriores”24, aún y  cuando 

los techos se caracterizan por ser de dos aguas con armazón de madera cubierta de teja. 

                

     Imagen 32: Modelo de techo taxqueño             Imagen 33: Tipologia arquitectónica propuesta por Babini 

                                                           
24

 Junta  (2007), p.p. 11. 
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Imagen 34: Simulacros de vigas 

 
“Los entrepisos y cubiertas por lo general se construyeron con vigas de madera 

apoyadas sobre los mismos muros, librando el claro más corto. En el caso de entrepisos, 

sobre las vigas se colocaba una tapa que podía ser de madera o de baldosas de barro. En 

el caso de las cubiertas, se construía un sistema a base de vigas de madera y morillos 

dispuestos a una, dos, tres o cuatro aguas, sustentando tejas de barro, o bien, azoteas 

horizontales con petatillo, conformando las pendientes de captación de agua pluvial”25. 

Pero como observamos en la imagen anterior (34) la viguería no tiene valor constructivo, 

toda vez que la mayoría de las casa en Taxco hoy día tienen losas de hormigón armado, las 

vigas solo son un recuerdo de aquellas que tenían un valor constructivo y estructural, las 

vemos actualmente algunas veces realizadas en madera, otras en cemento pintado y 

últimamente introduciéndose las prefabricadas de unicel forradas con pintura plástica 

texturizante. 

                                                           
25

 Babini (2005), p.p. 220. 
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Lo mismo sucede con los marcos de las ventanas y puertas, que se caracterizaban 

por ser realizadas con piedras de cantera labrada (ver imagen 35), no obstante se ha 

popularizado el acabado en cemento pigmentado y con cargas de mármol, el cual se 

matelina y corta para obtener la apariencia del modelo tradicional, y donde el arco de 

medio punto no trabaja estructuralmente solo trabaja en su apariencia, en la calle de 

Reforma se puede observar una galería de estas propuestas de arte contemporáneo en el 

espacio público de Taxco, construidas por parte de sus ciudadanos. 

  

Imagen 35: Marcos de piedra de cantera  Imagen 36: Solución contemporánea de marcos 

Pero esta tendencia no solo viene en las construcciones comerciales y civiles, sino 

también institucionales, cito a Fernando Curiel:  

Dura realidad. ¿Cómo evitar que un comité de vecinos "progresistas", da cuerdo 

con las autoridades, cumpla sus "promesas políticas" y trueque, por ejemplo, una 

sencilla y bien delineada fuente labrada en cantería, por una nueva de cemento, 

lisa, de color negruzco, adornada con unos cuantos azulejos desportillados? ¿Cómo 

evitar que un párroco, lleno de piedad pero con ayuno de gusto, con motivo de la 

fiesta titular de un santo haga una "mejora" consistente en pintar su templo -

construido de sillería de piedra o cantería cuidadosamente labrada- a la cal, de 

azul, lila o naranja; o bien, cambiando antiguos pisos de maderas finas, obra de 

hábil carpintería, por mosaicos fríos de colores chillantes o por simples pisos de 

cemento? Los retablos, maravillosos conjuntos en donde tallas y dorados se 
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combinan con pinturas y esculturas, han sido en incontables casos substituidos por 

"cipreses" de ladrillo o de cemento, y en algunos casos como refinamiento de lujo, 

de "tecali". ¿Cómo evitar la destrucción, so pretexto de modernización, de árboles 

centenarios, de rincones de belleza natural y paseos públicos de indiscutible 

atractivo? ¿Por qué derribar innecesariamente una casona que desde hace 300 

años servía de "Casa de Cabildo", para edificar otra de adobe con techos de vigueta 

de hierro, revistiendo su exterior con cemento gris y adornándolo con un farol de 

pésimo gusto, amen de la correspondiente lápida conmemorativa de la "mejora"?26 

 Esto se hace cada año días antes de la Semana Santa, cuando se remoza con 

pintura acrílica todas las paredes, hasta se pintan los ladrillos y el cemento que los separa 

para que parezcan ladrillos y cemento, es el extremo de la hiperrealidad en 

taXcoLandiA.com.  

 

Imagen 37: Pared de la Av. Plateros en víspera de la Semana Santa. 

                                                           
26

 Curiel Defossé, Fernando (2008). Taxco: La perspectiva urbana. Universidad Nacional Autónoma de 
México, p.p. 136. 
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 Este exhaustivo análisis me proporciono una serie de materiales y soluciones 

constructivas contemporáneas, que si bien son actuales se mezclan con otras de la época 

colonias, lo cual me motivo a incluir la presencia de estas dos persistencias estilísticas en 

mi propuesta de intervención, de lo cual hablaré en la segunda parte de este trabajo. Y a 

continuación presentaré el espacio que seleccioné para realizar mi propuesta, esta 

selección está fundada en razones icónicas, logísticas, afectivas y de gestión, debido a que 

este lugar es un icono urbano de Taxco y era donde laboraba en el momento de realizar la 

obra, lo cual me facilitó la obtención de permisos de instalación de la obra y también a 

usar el taller de escultura para producir las piezas de la obra, finalmente por ser el lugar 

donde convivía la mayor parte del tiempo de mi estancia en Taxco, genere sentimientos 

de pertenencia e identidad que me motivaron a realizar este proyecto. 
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2. Allá en la hacienda había un chorrito se hacía grandote se hacía 

chiquito 

 

NAU  OUAC MI   AGUA  SE  SECÓ 

Noxaloauac 
xocquipia  atl, 

aman,  ¿canon  natliz? 
aman,  caznamiquiz 

 

A mi  arena se le  secó  su  agua,  
ya  no  tiene  agua  

ahora,  ¿en  dónde  beberé?  
ahora,  quizás moriré  de  sed. 

TIayaca  quimamati'  ce  ameyahli', 
¡ Xalitecos  xnechihlican! 

¿Canon  unca  un  atl? 
TIamo  namiquiz. 

 

Si  alguien  sabe  de  algún  manantial,  
i hombres  de  las  tierras  arenosas,  díganme! 

¿En  dónde  se  encuentra  esa  agua?  
Si  no,  moriré  de  sed. 

Pampa aman  naamictinemi'  
uan  nitlayocoxtinemi'.  

 

Porque ahora  ando sediento  
y  algo  se  me  anda  desgranando:  el  corazón. 

Zan  ipampa  un  atl,  
un  atI  tlin  techmaca  tonemiliz,  
un  achipactli  quen  ce  tezcatl,  
can  zan  notehua'  ueltimotaz,  

ueltiquitaz  mixco',  
un  mixco  iuan  mixayo'. 

 

Sólo  por  culpa  de  esa  agua, 
esa  agua  que  nos  da  la  vida,  

esa  agua limpia  como  un cristal,  
donde  tú  mismo  te  podrás  ver,  

podrás  ver tu  rostro,  
ese  rostro  con  tus  lágrimas. 

Aman  mixayo  chachapaca',  
ipan  un  achipactli'  

aman  xnezi'  catleua'  mixayo'  
uan  catléua'  achipactli'.  

 

Ahora  tus  lágrimas  caen  repetidamente 
sobre  esa  agua  limpia,  

ahora  no  se  ve  cuáles  son  tus  lágrimas 
y  cuál  es  el  agua  limpia. 

Aman  ueIticoniz  mixayo',  
un  mixayo'  

tlinpeyahuin  ipan  moxayac. 
 

Ahora  podrás  beber  tus  lágrimas, 
esas  lágrimas  

que  resbalan  sobre  tu  cara. 

Aman  xconi'  mixayo',  
pampa un  atl tlin  tehua'  
tictetemotinemi'  ouac,  
maau  ouac  XALlTECO. 

 

Ahora bebe tus lágrimas,  
porque  esa  agua  que tú   

andas  buscando,  se  secó,  
tu  agua  se  secó,  hombre  de  las  tierras  arenosas. 

Alfredo Ramírez, 1983.27 

                                                           
27

 Ramírez, Alfredo (1983). “Cuatro poemas en náhuatl de Xalitla, Guerrero”. En Estudios de Cultura Náhuatl, 
N°16, Instituto de Investigaciones Históricas - Universidad Nacional Autónoma de México. Consultado el 26 
de marzo de 2011 en http://www.iih.unam.mx/publicaciones/revistas/nahuatl/pdf/ecn16/252.pdf.   
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Es momento de escribir sobre el lugar y el sitio especifico elegido para contener la 

propuesta artística de esta tesis, se trata en primer momento de una de las primeras 

haciendas mineras de la Nueva España, la Ex Hacienda del Chorrillo en la Ciudad de Taxco 

de Alarcón en el Estado de Guerrero. 

 Lo primero que quiero mencionar es que esta ex hacienda antes de llamarse del 

chorrillo pertenecía al complejo minero de la Hacienda de Cantarranas: “Ubicada en la 

ciudad de Taxco, construida entre 1525 y 1534 por los soldados de Cortés en un principio 

no le perteneció al conquistador. Originalmente se le conoció como "Hacienda de 

Cantarranas", nombre que tomó por haberse construido en una zona donde abundan 

estos batracios”28, lo cual sería anecdótico si no fuera porque nos da el indicio de una 

realidad perdida, la presencia de mucha agua, que propiciaba un hábitat adecuado para 

las ranas, y por lo cual los conquistadores la eligieron para instalar ahí, para poder 

desarrollar una maravilla de la ingeniería hidráulica de su tiempo, éste ingenio minero 

para el beneficio de la plata, el cual dio origen a la actual población de Taxco de Alarcón. 

          

Imagen 38: Parte del acueducto que llevaba el agua a los molinos de agua. Imagen. 39: Molino de agua. 

 

                                                           
28

 Ruíz Ocampo, Javier (2007). “Las haciendas mineras”. En Guías Turísticas e Históricas de Taxco. Taxco de 

Alarcón: Diseño Digital, p.p.10. 
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El auge de las Haciendas Mineras, se inicio cuando fueron incorporadas al "Sistema 

de Patios", método inventado por el minero español Bartolomé de Medina, quien 

llegó a la Nueva España en 1553, y en los dos años posteriores perfecciono su 

sistema en Pachuca Hidalgo, que consiste en obtener la plata por medio de la 

mezcla del mineral con la sal y el mercurio. Esta mezcla se lavaba para separar los 

residuos de tierra y el mercurio con plata, esta última se calentaba para obtener 

plata pura. El proceso requiere grandes cantidades de agua, por lo que todas las 

Haciendas Mineras están construidas al lado de un río. Incorporando el sistema en 

Taxco, se inicia la construcción de varias de ellas, pero, a diferencia de las de 

Pachuca, Zacatecas y Guanajuato, de tracción animal, debido a la gran cantidad de 

agua que existía en esta zona, se utiliza la fuerza hidráulica para operarlas.29  

Sin embargo el elemento agua en esta zona es más que un insumo para la 

insipiente industria minera novohispána, era un símbolo de la gente que habitaba estos 

espacios en la época prehispánica y era tal la presencia del liquido que el cerro donde se 

encuentra edificado Taxco se llama El Atache30, es decir el “señor del agua” en náhuatl: 

“… roca mágica de donde de pronto brota el agua excesiva. Pero la montaña 

mágica sobre la que está construida Taxco tiene además otros poderes: dentro de 

ella y a sus alrededores está la plata. El "Señor de las aguas" de los antiguos 

mexicanos se convirtió en el "Señor de la plata" de los novohispanos. Agua y plata: 

vida y riqueza son los dones de Taxco.”31  

Este cerro contenía la gran mayoría de escurrimientos, comenzando por el rio 

Taxco y las barrancas secundarias de la Trinidad, Casallas, Las Guayabas, Chacoalco, 

Huayatenco,  El Arroyo y por supuesto Cantarranas32, del cual se puede observar un 

remanente los días después de fuertes lluvias, ya que los pobladores de la parte superior 

entuban la mayoría del agua, por esta cascada, la ex hacienda se llama el Chorrillo. 
                                                           
29

 Ruíz (2007), p.p 7. 
30

 Babini (2005), p.p. 140. 
31

  Ruy Sanchez, Alberto (1989). “Acercarse a Taxco”. En Artes de México, Nueva época, núm. 5, otoño de 
1989. 
32

 Babini (2005), p.p. 52. 
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Imagen 40: Escurrimiento del Chorrillo. 

 En las instalaciones de la Escuela Nacional de Artes Plásticas que ocupan 

actualmente la ex hacienda del Chorrillo, encontramos un antiguo contenedor de agua, 

que según me dijeron los trabajadores de la escuela, era un pequeño estanque donde 

vivían algunos patos como parte de la 

ambientación del lugar, posiblemente 

cuando se utilizó la hacienda como 

hotel33, un indicativo más de la 

persistencia del agua como tema 

cultural en esta edificación, no 

obstante el lugar a caído en desuso y es 

solo utilizado como un espacio de 

tránsito peatonal en la escuela, es en 

este lugar donde se realizará la obra.                      Imagen 41: Antiguo estanque de recreo. 

                                                           
33

 “La hacienda se convierte en hotel, Jhon y Esther Sullivan sus propietarios, conservan el casco original y 
parte de su acueducto, además que construyen una serie de casas que funcionan como habitaciones en 
renta para turistas”, Herrera Vázquez, Pia. “Ex Hacienda del Chorrillo, patrimonio de la UNAM con más de 
450 años de historia”. En Gaceta UNAM, núm. 2899, 13 de febrero de 1995,  p.p. 19. 
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Pero como siempre el olvido humano deja que la naturaleza se extienda como 

opositor34 de la obra humana, es por ello que en este sendero formado por la escoria 

sobrante de la extracción de plata, la vegetación se abre paso para crear un micro hábitat 

lleno de árboles, arbustos y plantas, es decir un espacio verde y salvaje único en la 

escuela, donde puede descansar la mirada, reflexionar y estar. 

  

Imagen 42: Vista superior del sitio elegido para la intervención. 

 Para finalizar intentare caracterizar el sitio específico de la propuesta como un “no 

lugar” según Marc Auge, este es un espacio sin memoria, parece que nada ha pasado ahí, 

y si paso es sofocado por la necesidad de transitarlo rápidamente para llegar a clase, “… la 

modernidad no los borra, [a los lugares] sino que los pone en segundo plano”35. Es un 

espacio donde no sucede nada, donde no hay puntos de vista para el que camina, solo una 

subida que requiere de su esfuerzo y concentración,  “La evocación de la tierra que 

desaparece basta para suscitar la del pasajero que todavía trata de percibirla: ya pronto 

no será más que una sombra, un rumor, un ruido”36. Son espacios mediadores entre un 

origen y un fin, digamos es un libramiento más veloz que el de subir las escaleras y 

encontrarte con alguien que te puede entretener, es un espacio para la soledad: 

                                                           
34

 Duque, Félix (2001). Arte público y espacio político. Madrid: Akal, p.p. 15-16. 
35

 Augé, Marc (2000). Los “no lugares” espacios del anonimato: una antropología de la sobremodernidad. 
Barcelona: Gedisa, p.p. 82. 
36

 Augé (2000), p.p. 93. 
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“No es sorprendente, pues, que sea entre los "viajeros" solitarios del siglo pasado, 

no los viajeros profesionales o los eruditos sino los viajeros de humor, de pretexto o 

de ocasión, donde encontremos la evocación profética de espacios donde ni la 

identidad ni la relación ni la historia tienen verdadero sentido, donde la soledad se 

experimenta como exceso o vaciamiento de la individualidad, donde sólo el 

movimiento de las imágenes deja entrever borrosamente por momentos, a aquel 

que las mira desaparecer, la hipótesis de un pasado y la posibilidad de un 

porvenir.”37 

 Los no lugares, son aquellos espacios que quedan entre los lugares, donde se anula 

lo social por lo funcional, donde se dicta como se está, donde se individualiza a la persona, 

es anónimo,  “…El espacio de la sobremodenidad está trabajado por ésta contradicción: 

sólo tiene que ver con individuos (clientes, pasajeros, usuarios, oyentes) pero no están 

identificados, socializados ni localizados (nombre, profesión, lugar de nacimiento, 

domicilio) más que a la entrada o a la salida…”38, este es un espacio donde no hay 

sucesos, no hay historias que contar, no hay personas, solo transeúntes. 

 

Imagen 43: Es un corredor que corta el camino entre la calle del Teleférico y la calle del CEPE, donde transitan 

la mayoría de los alumnos que van a los talleres de pintura, grabado, esmalte, fotografía y cera perdida. 

 Este es el espacio público elegido para la propuesta, y a partir del cual se desarrollo 

un el proyecto para presentar en el concurso de modelado virtual Desing It: Shelter 

competition, a continuación presento el concurso para contextualizar mi propuesta. 
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 Augé (2000), p.p. 92. 
38

 Augé (2000), p.p. 114. 
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3. Design It: Shelter Competition 

 
 

  

Imagen 44: Imagen representativa del concurso Design It: Shelter Competition 

 

Dentro del marco de las exhibiciones Frank Lloyd Wright: From Within Outward y Learning 

By Doing, el Museo Guggenheim y Google  SketchUp, tomaron la iniciativa de hacer una 

convocatoria39 a diseñadores aficionados y profesionales de todo el mundo para que 

diseñaran un refugio 3-D  a través de las herramientas  Google SketchUp40 y Google Earth. 

El concurso es una extensión de la muestra de FLW Learning by doing, una exposición en 

el Guggenheim Museum Sackler Center for Arts Education donde aparecen planos, 

fotografías, y modelos de los refugios construidos por estudiantes del Frank Lloyd Wright 

School of Architecture. Durante las últimas décadas, los estudiantes de esta escuela han 

asumido el reto de diseñar, construir, y vivir en refugios emplazados en los paisajes de la 

escuela en Arizona  y del Wisconsin campus. Al trabajar sobre estos refugios, los 

estudiantes consideran las necesidades humanas en materia de seguridad y comodidad,  

                                                           
39

 Para ver la convocatoria completa consultar el Anexo 1 de esta tesis. 
40

 Google SketchUp es un programa de modelado en 3D para profesionales. SketchUp es fácil e intuitivo y 
permite que cualquiera pueda crear modelos 3D de una manera rápida y precisa. Mediante el uso de 
modelos en 3D, los diseñadores pueden tomar decisiones con más información, comunicar detalles del 
proyecto y compartir ideas con colegas y clientes para alcanzar un objetivo común. 
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así como la relación entre la arquitectura y el lugar, aunado a lo anterior la invitación 

enmarca el diseño con cierta caracterización, una pequeña estructura de no más de 9.3 

m2 de superficie y no más de 3.6 m de alto, pensada para que una persona pueda dormir 

y trabajar; cabe destacar que este refugio está pensado para no haber luz, agua ni 

electricidad. Cada diseño deberá responder a un contexto específico de libre elección y 

posteriormente deberá ser geo-localizado vía Google Earth, se deben enviar cuatro 

imágenes bidimensionales, también publicar un video en YouTube41 y agregar el modelo a 

la Galería 3D de Google SketchUp42. 

En el transcurso del verano, cerca de 600 concursantes de más de 68 países 

presentaron sus diseños para este concurso. Los estudiantes del Frank Lloyd Wright 

School of Architecture fueron los encargados de elegir una lista de 10 finalistas los cuales 

están dispuestos a votación del jurado especializado y también a votación del público en 

el sitio www.guggenheim.org desde el pasado 7 de septiembre al 10 de octubre de 2009. 

Los finalistas incluyen representantes de Latinoamérica, Norteamérica, Europa y de 

Filipinas. 

 

Imagen 45: Volante para invitar a votar por los finalistas del concurso 
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 Museo Guggenheim. Video de los ganadores del concurso Desing It Shelter Competition. 2:48 min. 
Consultado el 22 de julio de 2011 en http://youtu.be/W3UUaP_4Pv4. 
42

 Google. Galería 3D. Consultado el 15 de Mayo de 2011 en http://sketchup.google.com/3dwarehouse/. 
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 A continuación describiré los modelos finalistas y ganadores43, con lo cual 

pretendo generar un contexto artístico para encuadrar el análisis de la propuesta que 

realicé para dicho concurso, y que gracias al apoyo del Programa de Estímulo a la Creación 

y Desarrollo Artístico de Guerrero en el 2010, pude construir en la ENAP campus Taxco. 

 Wave Shelter / Jonathan  Dowse / USA44 

Este refugio se encuentra en la Isla Shackleford de la costa de Carolina del Norte. 

Está diseñado para descansar en las dunas de arena, para evitar la erosión y para 

permitir que una gran cantidad de luz entre indirectamente. Utiliza los 

contenedores de transporte como principal material de construcción. Los 

contenedores de transporte son de acero, y al interior están revestidos con 

laminados de madera de piso a techo. 

  

  

Imagen 46: Vistas del refugio Wave Shelter 
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 Museo Guggenheim. Desing – It, shelter competition. Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter. 
44

 Dowse, Jonathan.  Wave Shelter. Consultado el 26 de abril de 2011 en http://www.guggenheim.org/new-
york/interact/participate/design-it-shelter/vote-for-shelters/project/200. (Finalista). 
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 Skin / Robert Wilson / UK45 

Skin es un refugio que se adapta a su entorno. El marco de metal simple puede ser 

forrado con diferentes materiales para proporcionar refugio en climas diferentes, 

manteniendo al usuario cómodo y protegido. La piel de madera es para su uso en 

los bosques, y la piel blanca se utiliza en condiciones muy duras, como la Antártida. 

 

  

 

 

  

 

 

 Imagen 47: Vistas del refugio Skin 
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 Wilson, Robert. Skin. Consultado el 26 de abril de 2011en http://www.guggenheim.org/new-
york/interact/participate/design-it-shelter/vote-for-shelters/project/203. (Finalista). 



42 
 

 A Bamboo Shelter in a Garbage Dump City / Gonzalo Raymundo / Filipinas46 

El refugio está situado en un vertedero de basura donde los pepenadores apenas 

sobreviven por la recolección y clasificación de basura. Hechas de bambú, un 

material indígena y sobre una base de concreto, es un refugio contra el calor o 

aguacero repentino por la tarde. El muro de bambú representa a las personas en 

conjunto que lleva el techo encima, que expresa el proverbio - Donde hay unidad 

hay fuerza-. Es un símbolo de la sostenibilidad y la esperanza. 

 

  

 

  

 

 

 Imagen 48: Vistas del refugio Bamboo Shelter in a Garbage Dump City 
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 Gonzalo, Raymundo. A Bamboo Shelter in a Garbage Dump. Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter/vote-for-shelters/project/214. 
(Finalista). 
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 Riverside Shelter / Natalia Schenfeld / Argentina47 

El diseño de esta vivienda utiliza los elementos constructivos y formales para 

proteger a una persona de clima, y al mismo tiempo para obtener beneficios, como 

la ventilación cruzada y orientaciones solares para la iluminación natural. Sus 

materiales representan la combinación de los recursos naturales y urbanos en este 

lugar. La madera y la costa, lo concreto y la ciudad, separados por el agua y unidos 

por el hombre. 

 

  

 

  

 

 

 Imagen 49: Vistas del refugio Riverside 
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 Schenfeld, Natalia. Riverside Shelter. Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter/vote-for-shelters/project/231. 
(Finalista). 
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 Before Sunset (Ecohab Shelter) / Rodrigo Montoya / Colombia48 

Este refugio se encuentra en el Eco-Parque Tayrona en la costa norte del Caribe de 

Colombia. Está diseñado en un terreno de roca, cerca de la playa, para aprovechar 

la mejor vista al mar. La malla sin terminar, hechas con madera de teca representa 

la vida humana con los sueños y deseos que no hayan concluido. La estructura de 

acero representa los sólidos valores que aprendemos en la vida para desafiar el 

presente y el futuro. 

 

  

 

  

 

 

 Imagen 50: Vistas del refugio Before Sunset (Ecohab Shelter) 
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 Montoya, Rodrigo. Before Sunset (Ecohab Shelter). Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter/vote-for-shelters/project/251. 
(Finalista). 
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 The Unfolding View Shelter / Chris Chin / USA49 

Este simple refugio está definido por un par de paneles de láminas de madera con 

bisagras. Estas 'paredes' se despliegan para formar un marco estructural, para que 

los paneles de policarbonato celular se puede conectar, proporcionando 

alojamiento, y dejando libre las otras paredes que permiten vistas hacia el Océano 

Pacífico. Aunque este refugio se muestra situado en la costa de Oregon, la 

construcción prefabricada y compactación le permite ser colocado en cualquier 

lugar rápidamente con un mínimo impacto sobre el medio ambiente. 

 

  

 

  

 

 

 Imagen 51: Vistas del refugio Before Sunset (Ecohab Shelter) 
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 Chin, Chris. The Unfolding View Shelter. Consultado el 26 de abril de 2011 en 
http:www.guggenheim.org/new-york/interact/participate/design-it-shelter/vote-for-shelters/project/286. 
(Finalista). 
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 Lagoa Azul Shelter: Between Water and Sky / David Huang / Brasil – USA50 

Lencois Maranhenses es un vasto desierto que se transforma en cientos de lagunas 

de color turquesa durante la estación lluviosa. Hecho principalmente de madera 

nativa, el refugio está anclado en los muelles de acero galvanizado y la sombra la 

proporciona un techo de tela, que canaliza las fuertes lluvias a un tanque de 

almacenamiento de madera para beber y lavarse. La cubierta del techo y las 

paredes de flotación están independientes de los muelles, registrando el nivel del 

agua que cambia según la temporada. 

 

  

 

  

 

 

 Imagen 52: Vistas del refugio Lagoa Azul Shelter: Between Water and Sky 
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 Huang, David. Lagoa Azul Shelter: Between Water and Sky. Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter/vote-for-shelters/project/625. 
(Finalista). 
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 Waste-Pickers Shelter / Alexander Niño Ruiz / Slovenia - Colombia51 

18.000 familias de recicladores recogen casi una décima parte de la basura diaria 

producida en Bogotá. Paradójicamente, muchos de ellos están protegidos por los 

residuos que recogen. Cuatro cajas de metal corrugado en forma de barril 

resuelven la ecuación de servir como un contenedor de residuos y refugio, fácil de 

tirar di-ciclo para que puedan trabajar y moverse. Un refugio cubierto de pintura 

reflectante para convertirse en una parte visible del medio ambiente urbano. 

 

  

 

  

 

 

Imagen 53: Vistas del refugio Waste-Pickers Shelter 
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 Niño Ruiz, Alexander. Waste-Pickers Shelter. Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter/vote-for-shelters/project/726. 
(Finalista). 
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 ZBOX: Transformative Folding Space / Zack Moros / USA52 

ZBOX es el espacio de plegado de transformación. ZBOX es una extensión del paseo 

marítimo. Sus materiales y forma se relacionan con la playa y el contexto marítimo. 

Se desarrolló como un espacio de encuentro social. Las paredes plegables crean 

una cubierta y superficie de escritura, se utiliza como que se desea, plegado se 

crea un refugio para estudiar, dormir y áreas de almacenamiento. El ZBOX 

parcialmente abierta define el espacio y permite al usuario experimentar el 

entorno que les rodea. ZBOX es reciclable, prefabricado y actualizable. 

 

  

 

  

 

Imagen 54: Vistas del refugio ZBOX: Transformative Folding Space 
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 Moros, Zack. ZBOX: Transformative Folding Space. Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter/vote-for-
shelters/project/1072. (Finalista) 
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 CBS - Cork Block Shelter/ David Mares/ Portugal53 

CBS se encuentra en el Vale dos Barris. Fue diseñado para ser un bloque ecológico 

y de vida. En un microclima que oscila entre el calor seco a húmedo y frío, la 

aplicación de corcho es una buena manera de aislar térmicamente la vivienda y 

que también proporciona aislamiento acústico para el estudio y el sueño. La 

fachada da a la interacción dinámica visual, en modo de estudio está lleno de vida, 

en modo de reposo se cierra para dar privacidad a sus ocupantes. 

 

  

 

  

 

Imagen 55: Vistas del refugio CBS - Cork Block Shelter 
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 Mares, David. CBS - Cork Block Shelter. Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter/vote-for-shelters/project/517 
(Finalista y Ganador del Público) 



50 
 

 Seashelter / David Eltang / Dinamarca54 

SeaShelter está situado en el mar de Wadden, costa única, con aguas poco 

profundas, con mareas de 1-3 metros del fondo marino y expuestos durante la 

marea baja. Es el hábitat de una gran variedad de aves y lobos marinos. SeaShelter 

ofrece la oportunidad de permanecer en el mar de Wadden, incluso con la marea 

alta, una oportunidad de descubrir la fauna de los fondos marinos cuando son 

inundados.  

 

  

 

   

 

 

Imagen 56: Vistas del refugio Seashelter 
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 Eltang, David. Seashelter. Consultado el 26 de abril de 2011en http://www.guggenheim.org/new-
york/interact/participate/design-it-shelter/vote-for-shelters/project/1168. (Ganador del Jurado). 
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 Este concurso significo para mí la oportunidad de trabajar artísticamente sobre un 

cúmulo de experiencias y observaciones surgidas de mi avecindamiento en Taxco, si bien 

yo soy de formación escultor, siempre he estado interesado en la utilización del CAD para 

la realización de mis trabajos, y el SketchUp es ideal para la arquitectura escultórica por su 

plasticidad tridimensional, lo cual vemos expresarse de múltiples maneras en los trabajos 

presentados a la convocatoria55, donde las formas cuadrangulares se comienzan a ver 

como elementos flexibles hasta el punto que se pierde el referente cubico para terminar 

en formas orgánicas, como vemos en esta pequeña muestra de los trabajos finalistas. 

 

Imagen 57: Refugios de izquierda a derecha: CellPak, Paper Cup Shelter y The Mangroove Symptom 

 Otro de los elementos significativos de haber concursado en esta propuesta, fue el 

de conocer el pensamiento de los demás participantes, que me propició una empatía en 

los temas ambientales y en la utilización de materiales contemporáneos, así como, los 

emplazamientos naturales, entre otras tantas que describiré más adelante. También 

observando los materiales de los contrincantes me percaté en la necesidad de extender 

mi trabajo de CAD más allá de renders foto realistas e incursionar en el video, ya que el 

material que presenté en este rubro fue muy básico, a diferencia de otros donde se 

denota un trabajo arduo e importante para comunicar las propuestas y que todas estas 

observaciones me permitieron crecer como artista, así como tener un mayor impacto en 

mi público lo cual me dio acceso a la beca del PECDAG con lo cual financiar la construcción 

in situ del proyecto, con una libertad para desarrollar un proceso creativo donde el tema 

financiero no fuera un impedimento.  
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 Museo Guggenheim. Desing – It, shelter competition. Consultado el 26 de abril de 2011 en 
http://www.guggenheim.org/new-york/interact/participate/design-it-shelter/view-shelters. 
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 Segunda Parte: Tlachtli–Pelota: proyecto de arte contemporáneo en el 

espacio público de Taxco 
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El primer día que llegué a la Ex Hacienda del Chorrillo para unirme al claustro de 

profesores del Centro de Extensión Taxco de la Escuela Nacional de Artes Plásticas, me 

tropecé en las áreas verdes de la escuela con la ruina de lo que fue un balón de fútbol, lo 

cual de momento me pareció extraño, pero cuando me encontré con la toponimia de 

Taxco comenzó a tener sentido. La toponimia de este lugar se bifurca en la antigüedad 

mexicana y la época novohispana, de donde recoge el nombre de uno de sus más ilustres 

hijos, se trata del novelista Juan Ruiz de Alarcón, nacido en 1581 en esta localidad56. Y de 

la antigüedad mesoamericana se retoma el nombre de Taxco que proviene del vocablo 

náhuatl tlachco57 que significa lugar donde se juega pelota58, es una palabra compuesta 

por: tlacht que se traduce como juego de pelota y el locativo -co que significa en o el 

lugar59. 

  

Imagen 58: Tlach – juego de pelota, pictograma del códice Borgia, lamina 42. 

 

Sin embargo, en la ciudad de Taxco no encontramos un campo del juego de pelota 

antiguo, tampoco algún elemento tridimensional que pueda atizar el imaginario colectivo 

y la identidad precolombina de sus habitantes en torno a su toponimia, solo encontramos 

un resabio en el logotipo utilizado por las administraciones municipales, reproducido 
                                                           
56

  Wikipedia. Juan Ruiz de Alarcón. Consultado el 13 de marzo de 2011 en 
http://es.wikipedia.org/wiki/Juan_Ruiz_de_Alarcón. 
57

 Wikipedia. Taxco de Alarcón. Consultado el 13 de marzo de 2011 en 
http://es.wikipedia.org/wiki/Taxco_de_Alarcón#Toponimia. 
58

 Rodríguez Villegas, Manuel. AULEX Diccionario Nahuatl – Español en línea. Consultado el 28 de septiembre 
de 2009 en http://aulex.org/nah-es/. 
59

 Gobierno del Estado de Guerrero. Página oficial. Consultado el 28 de septiembre de 2009 en 
http://www.guerrero.gob.mx. 
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innumerables veces en el mobiliario urbano y en algunos mosaicos de las calles a manera 

de placa conmemorativa, perdiendo su simbolismo y reduciéndolo a un signo visual de 

consumo. Y pregunto, ¿Dónde están las pelotas? del lugar donde se juega a la pelota. 

 

  

Imagen 59: Convivencia familiar alrededor del futbol en los Jales de Taxco. 

 

Hoy día las pelotas de Tlachco se encuentran en los innumerables campos de 

fútbol en la ciudad y sus alrededores, es el balón un elemento plástico alrededor del cual 

se generan fuertes lazos de identidad social. Pero ¿qué encierra simbólicamente un balón 

de fútbol en la vida contemporánea?, algunos dicen que “el mundo gira alrededor de un 

balón”, y otros más poéticos como Juan Villoro dicen, es “el epicentro de sinergias 

colectivas en ocasiones inexplicables… argamasa cosmética que fija los ladrillos apilados, 

uno sobre otro, del lazo social contemporáneo”60, por ello tomamos el balón de fútbol 

como origen y pretexto de este proyecto, titulado tlachtli que significa pelota en náhuatl. 

Ahora bien, para analizar esta propuesta es necesario describir y reflexionar sobre 

algunos conceptos como son arte contemporáneo, universos virtuales, materiología y 

objetología.  

                                                           
60

 Villoro, Juan (2006). Dios es redondo. Barcelona: Anagrama. 
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Por arte contemporáneo entiendo “la actividad teórico - práctica de carácter 

proyectual, que tiene por objetivo la elaboración formal y técnica de obras, objetos, 

imágenes, y espacios que responden siempre de manera pertinente, a una necesidad 

individual o colectiva del hombre… la actividad proyectual conduce a la elaboración… [de 

diseños]. El diseño es así una actividad… con un alto grado de complejidad, en la que 

intervienen factores de muy diferente tipo y procedencia. Sus contornos y fronteras no 

están claramente definidos por que es un universo en expansión… Intervienen en su 

realización factores socio-culturales, naturales, conceptuales, formales, materiales, 

técnicos, biológicos y psicológicos. No es un sistema rígido, cerrado, sino el manejo y 

reorganización permanente de los factores que intervienen en la solución de un problema 

concreto. Es un sistema abierto, reorganizativo…”61 multiniveles, pluridimensionales,  

polimórficos, policéntricos, autorreguladores, polisistémicos, y se caracterizan por un alto 

grado de apertura, expansión y plasticidad. 

Las prácticas del diseño se realizan a través de diversos sistemas, procedimientos y 

procesos, que pueden ser tecnológicos, artísticos, lingüísticos, mercantiles, científicos, 

productivos, ergonómicos, simbólicos, decorativos y eficientistas, entre otros. Los 

procesos más significativos en el diseño proyectual son los siguientes: conceptualización, 

formalización, materialización, objetivación, planeación, comunicación, ejecución y 

evaluación, que se desarrollan de manera desordenada dependiendo cada caso. “El diseño 

puede comenzar con un concepto, con el uso de un material, con la aplicación de una 

técnica o la formulación de un objeto y en todo caso,  lo importante es que el trabajo 

recorra en la dirección que le convenga.”62  

El diseño contemporáneo es un arte intermedio, por que elabora obras, objetos y 

espacios a la vez útiles y estéticos. “Es una actividad estructurante y estructurada que se 

balancea entre lo sensible y lo inteligible, entre lo artístico y la mercadotecnia, lo material 

y lo inmaterial… lo natural y lo artificial, lo real y lo ideal, lo objetivo y lo subjetivo”, tiene 

como modelo la innovación y sus productos están sujetos a ilimitadas posibilidades de 
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 Pérez (2003), p.p. 55-56. 
62

 Pérez (2003), p.p. 57-58. 
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transformación, es pura procesualidad sin fin, algunos de los procedimientos constructivos 

más importantes del diseño son: “cambios, imitaciones, variaciones, evoluciones, 

modificaciones, alteraciones, crecimientos, deformaciones, transmutaciones, fusiones, 

hibridaciones y desplazamientos”63, sus productos son “entidades hibridas, medio 

imágenes-medio objetos,  medio imágenes-medio sujetos, medio sujeto-medio objeto; 

desaliñados, desjerarquizados, derivados unos de otros, entes que han diluido su 

identidad y que se interpretan, que se contaminan recíprocamente.”64 

La realidad de nuestro tiempo emerge en el diseño como discurso, como mensaje 

semiótico, todo el arte contemporáneo habla por medio de sus materiales, objetos y 

universos virtuales65 que se licuan en un mundo transitorio, instituyendo por algún tiempo 

una nueva realidad artificial, simulan ser pero no son, son “el producto de una síntesis 

irradiante de modelos combinatorios… Hoy en día, la abstracción ya no es la del mapa, la 

del doble, la del espejo o la del concepto. La simulación no corresponde a un territorio, a 

una referencia, a una sustancia, sino que es la generación por los modelos de algo real sin 

origen ni realidad: lo hiperreal.”66 

Ahora bien, este proyecto de arte contemporáneo se da en un espacio público sui 

generis, que es Taxco de Alarcón, Guerrero67, un lugar donde el paradigma de la 

conservación urbana condiciona la intervención artística a materiales68, formas69 y 

técnicas70. Por lo cual se propone darle dos tiempos a esta propuesta, un tiempo 
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semiótico71 y otro simbólico72, lo semiótico es una estética basada en la simulación, donde 

los significados tienen que ver con nuestra artificialidad material e inmaterial, y lo interior 

que tienen que ver con la experiencia individual o colectiva surgida del uso de este 

dispositivo espacial, el cual nos adentra en “los componentes… implicados en el proceso 

de apropiación, describiendolos como una relación dialéctica y cíclica entre una 

componente de 'acción-transformación' y otra de 'identificación simbólica'. Mediante la 

acción sobre el entorno, la persona y la colectividad transforman el espacio, dejando su 

impronta, y lo incorporan en sus procesos cognitivos y afectivos de una manera activa y 

actualizada. Es decir, lo dotan de significado individual y social a través de los procesos de 

interacción. Por la interacción simbólica la persona y el grupo se reconocen en el entorno 

y se autoatribuyen sus cualidades como definitorias de su propia identidad”73, 

permitiéndonos a través de dinámicas de participación ciudadana y su uso cotidiano 

dimensionar el proyecto en la esfera pública de la ciudad. 
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1. Universos Virtuales 

 

Universos virtuales son la simulación en su máxima expresión, “al contrario que la utopía, 

la simulación parte del principio de equivalencia, de la negación radical del signo como 

valor, parte del signo como reversión y eliminación de toda referencia.”74, son “el extremo 

abstracto y conceptual del diseño. Son imágenes que se generan a partir de modelos 

teóricos, traducidos luego a lenguajes numéricos y que forman parte sin embargo, de 

procesos de virtualización de la vida individual y colectiva del hombre. Los universos 

virtuales tienen raíces histórico-sociales muy concretas, en la medida en que traducen en 

formas y figuras, la experiencia vivida y pensada por el hombre de nuestros días. Lo virtual 

es una manera de ver, de vivir, de representar esa vida y de actuar en el mundo 

intermedio contemporáneo. No es una experiencia aislada a pesar de su apariencia 

estrambótica. Convergen en su realización saberes teóricos, prácticos, técnicos y visiones 

generales sobre la realidad y sobre el mundo actual. Generalmente son imágenes 

elaboradas por equipos que cuentan con mercados internacionales de consumidores, 

dado el alto costo de su producción. En dichos equipos participan ingenieros, técnicos, 

diseñadores, filósofos, informáticos y grupos de investigación…La complejidad de los 

mundos virtuales es astronómica y sintetiza al conjunto de características del arte-diseño 

de nuestro tiempo: imágenes sorprendentes, prodigios técnicos, sintaxis descosidas, 

léxicos obscuros y ambiguos, estetización de las formas, recorridos laberinticos, 

construcciones fragmento por fragmento, estructuras flexibles y conceptualizaciones 

superpuestas. Con la creación sintética, es la modelización de la información estética lo 

que se produce.”75       

Estos universos virtuales forman modelos donde el arte contemporáneo se 

presenta en toda su forma proyectual, donde impone su visualización a la realidad es lo 

que las metodologías de diseño siempre soñaron76. “Ya no se puede fantasear acerca de la 
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minuciosidad de un programa, su sola observancia es vertiginosa, pues pertenece a un 

mundo que no desfallece. Hay que tener en cuenta que el mismo modelo de infalibilidad 

programática, de seguridad y de disuasión máximas, es el que rige hoy el campo de lo 

social. He aquí el último rizo de la parábola nuclear: la operación minuciosa de la técnica 

sirve de modelo para la operación minuciosa de lo social. Nada será ya dejado al azar, y sin 

embargo, ésta es la socialización que se inició hace siglos, pero que acaba de entrar en su 

fase acelerada, hacia un límite que se creía explosivo (la revolución), y que de momento se 

traduce en un proceso inverso, implosivo, irreversible: disuasión generalizada de todo 

azar, de todo accidente, de toda transversalidad, de toda finalidad, de toda contradicción, 

ruptura o complejidad, en una socialidad irradiada por la norma, volcada a la 

transparencia de señales de los mecanismos de información”77, esta posibilidad de 

permanencia de la información hace más fuerte la simulación, al encontrarse ligada a los 

nuevos medios como internet, por ejemplo, el proyecto Google Earth es un proyecto 

donde se sintetiza la apariencia del espacio público del mundo, es ahí donde parece surgir 

lo que tiene valor de lo que no es. 

Nuestro proyecto es desarrollado originalmente como un modelo por 

computadora construido en el hiperespacio, es decir dentro de una máquina, de tal forma 

que su ejecución tratará de simular ser este modelo, constituirse como una hiperrealidad 

en el mundo físico. Su multiplicidad objetual le permite configurarse a través de la 

acumulación de la información, tenemos un modelo virtual en Google Earth y Google 

3dwarehouse78, tenemos un video en Youtube79, tenemos la impresión de fotomontajes 

realistas en papel. Todo lo anterior se va combinando para crear una imagen simulada 

compleja, donde cada presentación tiene sus limitantes y su intención. Los modelos 

virtuales buscar crear esta simulación inmersiva del mundo, un lugar donde se aniquila a 

la realidad, “No se trata ya de imitación ni de reiteración, incluso ni de parodia, sino de 

una suplantación de lo real por los signos de lo real, es decir, de una operación de 
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disuasión de todo proceso real por su doble operativo, máquina de índole reproductiva, 

programática, impecable, que ofrece todos los signos de lo real y, en cortocircuito, todas 

sus peripecias. Lo real no tendrá nunca más ocasión de producirse —tal es la función vital 

del modelo en un sistema de muerte, o, mejor, de resurrección anticipada que no concede 

posibilidad alguna ni al fenómeno mismo de la muerte80… lo que ha estado en juego ha 

sido el poder mortífero de las imágenes, asesinas de lo real, asesinas de su propio 

modelo…”81. 

 

1.1 Diseño asistido por computadora (CAD) 

 

El diseño asistido por computadora tiene ya muchos años, su origen se encuentra en las 

posibilidades técnicas que la era moderna ofrece al negocio de la construcción, “La 

disciplina creativa que hoy llamamos diseño surge a consecuencia de las nuevas 

circunstancias que la Revolución Industrial impone al proceso creativo y obliga a 

diferenciarlo de la simple producción”82. Estructuras prefabricadas, muros resumidos a 

paneles, grúas gigantescas, desarmadores y martillos hidráulicos, una cantidad increíble 

de tornillos para cada necesidad, etcétera; toda una industria de la construcción que nos 

permite entender el diseño, como proyecto, un plan donde hay que organizar una 

complejidad de materiales físicos, humanos, presupuestos, compras, transportación, entre 

otras, y donde parece que la forma se libera de la cuadrangularidad en el espacio virtual 

de los programas de computo, “… la nueva era industrial trae como consecuencia más 

importante la pérdida de la fuente de motivación para dar paso a una nueva forma de 

creación abstracta, no surgida directamente del contacto con la realidad, la vena creativa 

no puede ya fluir de esa realidad palpada, sino de una hipotética realidad plausible …”83, 

donde el trabajo del diseñador deja de realizarse en el espacio físico para transportarse a 
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espacios cibernéticos donde los puntos de vistas son infinitos, donde el ensayo de prueba 

y error no involucran la creación de un objeto real, donde el artista tiene permiso de 

explorar las diferentes variaciones de sus inquietudes, recorrer todos los caminos que se 

va imaginando, corregir hasta la saciedad gracias al actual paradigma creativo de “Los 

nuevos medios digitales que han revolucionado en años recientes las condiciones de la 

arquitectura, el día de la regla-t y el rapidografo, del plano y del dibujo a mano alzada de 

las diferentes perspectivas están contados, pronto la práctica profesional no será capaz de 

permitirse el lujo de trabajar sin CAD, ni páginas web, ni correos electrónicos, ni privarse 

de la transferencia de datos digitales, algunos arquitectos jóvenes e innovadores de la 

libre empresa han provechado la oportunidad para explorar los límites de las posibilidades 

digitales, su búsqueda de superficies con formas libres, formas que sólo son posibles a 

través de los medios que el software de animación ofrece”.84  

 

 

  

 

 

 

Imagen 60: Intervención arquitectónica 

sobre edificio barroco de Budapest, Erick van 

Egeerat, 1994.  

 

 

 

 Imagen 61: Torre interactiva  para la ciudad de 

Doetinchem, Nueva Zelanda, NOX / Lars Spuybroek con 

Pitupong Choawakul, Nobert Palz, Wolfgang Novak, Joan 

Almekinders con el artista Serafijn, 1998. 
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Es importante advertir que el desarrollo del software de animación fue diferente al 

del CAD en el siglo pasado, ya que tenían diferentes objetivos. Recuerdo que hace 15 años 

dibujaba en autocad para planificar mis diseños y después tenía que prácticamente hacer 

otro modelado en 3d max para realizar renders (interpretación) para la comunicación de 

mis proyectos. No obstante, en este incipiente siglo, el desarrollo de paquetería hibrida y 

más fluida en la compartición de información tridimensional han permitido una  mayor 

eficiencia de la paquetería, actualmente utilizo el mismo programa para modelar, 

gestionar dibujos técnicos, interpretaciones fotográficas o videográficas del modelo, 

analizar pesos y costos, realizar goelocalizaciónes y hasta imprimir tridimensional las 

maquetas, es este el caso del programa que utilicé para el diseño de mi proyecto, es decir, 

el programa de diseño asistido por computadora SketchUp de la empresa Google.  

La compartición de información es muy importante en el diseño actual, el interés 

personal en trabajos existentes y por compartir los modelos propios es motivado por el 

mismo programa. Es el caso de mi propuesta; ya que el motivo inicial de este proyecto fue 

la pelota, tome un modelo85 construido y ofrecido en el espacio virtual por medio de la 

galería 3d de SketchUp86 para transformarlo por medio de una evolución.  

 

Imagen 62: Aquí observamos la ventana de dialogo de la Galeria 3d que contiene el modelo base. 
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Este diseño se incrusta en las nuevas exploraciones de geometrías orgánicas para 

la elaboración de espacios habitables, el cual a partir de la composición esférica de 

combinación entre pentágonos y hexágonos, como la de los balones tradicionales, se 

evoluciona hacia un espacio esférico de muros y ventanas intercaladas donde se puede 

acceder a pie para estudiar, dormir, meditar y observar, de lo cual hablaré más adelante. 

 

 

Imagen 63: Geometría de un balón de futbol. 

 

 

Imagen 64: Vista de acceso principal al refugio, los hexágonos son los muros y los pentágonos las ventanas. 
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Hay que notar que este tipo de diseños biomórficos requieren un diseño 

estructural que se realiza a la par del diseño espacial, lo cual ha propiciado una disciplina 

específica para dicha labor, la ingeniería estructural: “... En los años 1950, 1960 y 1970, 

aparecieron materiales más moldeables como el hormigón y el plástico, que 

frecuentemente inspiraron a arquitectos e ingenieros para trabajar con las formas de una 

manera mas libre; pero la falta de planificación adecuada y de herramientas de 

producción limitaron la aplicación de estas superficies irregulares, alejándose totalmente 

de una nueva gama de opciones digitales en el trabajo con formas orgánicas, y de la 

traducción de estas estructuras libres a la realidad. Los involucrados en el proceso de 

planificación se vieron obligados a desarrollar nuevos métodos de trabajo”87. Estas 

estructuras por lo regular se encuentran ocultas, como ejemplo el trabajo del despacho de 

Frank O. Gehry Associates & Ink., donde observamos diseños de formas libres con medios 

convencionales como son las maquetas donde se define la capa exterior, a la cual se 

diseña una estructura interna a manera de esqueleto, que sostenga tanto la capa interior 

como la exterior. 

 

 

Imagen 65: Proyectos MKK y EMP de Frank O. Gehry Associates & Ink. 

 

                                                           
87

 Kloft, Harald (2001). “Structural Engineering in the Digital Workflow”, en Digital/Real: Blobmeister, fisrt 
built projects. Berlin: Birkhäuser, p.p. 199. 



65 
 

De tal forma; la ingeniería estructural es un arte que en un inicio se ha ocultado 

pero que en la actualidad se comienza a mostrar y a cobrar protagonismo estético a parte 

del que tradicionalmente tenía como soporte. Como a continuación muestro con el 

proyecto “La burbuja”, donde se exhibe un espacio interior al mismo tiempo que la 

estructura forma parte de esas formas libres, es decir, aquí la estructura y la forma son lo 

mismo, este es un ejemplo de las tendencias actuales de la construcción de espacios 

habitables, donde el diseño libre y la ingeniería estructural se idean como una sola cosa. 

 

Imagen 66: La burbuja.de Bernhard Franken Architekten, Frankfurt, 1999. 

 

De tal forma; en mí propuesta diseño hay una exoestructura que sostiene los 

pentágonos y hexágonos en un lugar específico, y que también sirven para elevar el 

espacio sobre el nivel de piso, donde se encuentra la tierra y el agua del estanque. 

 
Imagen 67: Diseño de estructura exógena de Talchtli. 
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Imagen 68: Esquema grafico donde se 

describen los materiales y su significado. 

 

La planificación en la construcción tradicionalmente surge de la bidimensionalidad, 

con croquis y bocetos, a partir de ellos se realizan los planos y esquemas para la 

formalización de planos en planta, alzado, e isométricos, al final se termina la proyección 

con visualizaciones de perspectivas y maquetas, lo cual complementa la información, sin 

embargo, hay que remarcar que el diseño surge de la bidimensionalidad, “En planificación 

digital, los arquitectos ya no preparan los dibujos en papel, ya no incluyen tablas de 

símbolos, o esquemas para reforzar los planes de gestión, en cambio, se genera una 

articulación mediante el modelo tridimensional, que contiene toda las piezas de 

información necesarias para implementar la ejecución, este modelo virtual es la base para 

la planificación”88, es decir se diseña a partir de la tridimensionalidad y los esquemas, 

planos y vistas son un sustrato del modelo maestro (ver imagen 68 y 69). 

 

 

 

 

 

 

 

Imagen 69: Plano general en perspectiva. 
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No obstante, para los tradicionalistas o como los llama Umberto Eco, los 

apocalípticos, el diseño asistido por computador presentaría la dificultad de trabajar o 

proyectar algo real en la irrealidad, con lo cual, pregonan un déficit en las capacidades 

perceptuales y creativas del diseñador, Pero esto no es necesariamente cierto, puesto que 

“… hay que recordar que en geometría se utiliza el término similitud para definir las 

formas que, teniendo tamaños diferentes, conservan las mismas proporciones, pues todas 

sus medidas ha aumentado o disminuido en la misma proporción. Este concepto es 

enteramente aplicable para definir una modalidad de las imágenes… tan conocida y útil 

como las maquetas, imprescindibles en el trabajo de arquitectos, urbanistas y 

escenógrafos. Y también es extrapolable, con la transformación planaria importada por la 

bidimensionalidad de la hoja de papel, a las proyecciones geométricas de los objetos 

tridimensionales”89. Lo cual se aplica también para el trabajo digital, es decir, que la 

representación geométrica que despliegan los monitores en nuestras actuales estaciones 

de trabajo operan con el concepto geométrico de similitud, por ello es posible poder 

visualizar y trabajar edificios gigantescos en nuestra ventada de trabajo de 15 o más 

pulgadas, de los cuales a la postre se formalizarán en la planeación ejecutiva con planos 

constructivos. 

 

 

Imagen 70: Plano de un modulo hexagonal del refugio Tlachtli. 
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Finalmente quiero hablar sobre una de las posibilidades únicas del Google 

SketchUp, la de diseñar tomando en cuenta la geolocalización del modelo, donde los 

sistemas de información geográfica nos permiten diseñar tomando en cuenta el entorno, 

y poder incrementar la imagen del proyecto para su telecomunicación, lo cual fue un 

requerimiento del concurso Design It al que fue inscrito este modelo. 

 

 

 

 

 

 

  

Imagen 71: Terreno virtual bajado de Google Earth. 

Es pertinente informar que por esta circunstancia tuve que hacer una ampliación de 

mi propuesta, ya que la pendiente de los terrenos en Google Earth no es muy detallada y 

para resolver esto modelé una abstracción de la base real donde se instalaría el refugio. Así 

como el terreno del Google Earth contiene la información GPS (Sistema de posisionamiento 

global), el modelo mantiene esta información al incrustarlo en Google Earth. 

 

 

 

 

 

 

Imagen 72: Aquí observamos la 

adecuación que diseñé para la 

presentación del modelo en Google Earth. 
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1.2 Modelos virtuales 

 

Como lo hemos dicho en el capítulo anterior, la compartición de la información es una 

característica fundamental del diseño digital, y son los modelos virtuales los contenedores 

de toda esa información que atesora nuestro diseño, es por ello que parte de los 

productos que nos requerían en el concurso de Design-It era subir nuestra propuesta a la 

Galeria 3d de Google SketchUp90, donde podrá ser descargado por cualquier persona en 

cualquier parte del mundo, esto es parte del desarrollo del CAD, construir conjuntamente 

esta colección de realidades digitales, realidades que se multiplican en copias infinitas por 

todo el mundo, modelos que contienen formas y texturas que simulan materiales y 

objetos con alta dosis de verosimilitud. “A la luz de esta evolución, se detecta sin mucho 

esfuerzo que la producción de imágenes en Occidente ha estado dominada por una doble 

y divergente preocupación intelectual. Por una parte, la voluntad de perfeccionamiento 

cada vez mayor de su función mimética, por la otra la exaltación de la capacidad ostensiva 

de la imagen como copia fidelísima de las apariencias ópticas del mundo visible, en una 

ambición que culmina con el hiperrealismo de la realidad virtual. Esta ambición ha sido del 

engaño a los sentidos y a la inteligencia, como ya avanzó Platón, pues quiere hacer creer 

al observador colocado ante la imagen que está en la realidad ante su referente y no ante 

su copia”91. Así como, en esta colección tridimensional se guarda  una copia del modelo 

que contiene la información de cada detalle del diseño.  

 

 

 

Imagen 73: Espacio virtual donde se almaceno 

el modelo Talchtli. 
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 Éste modelo ofrece a la mirada un nivel más profundo que el de la simulación, es el 

del conocimiento especializado, ésta es la razón que por la se nos pidió subir el modelo, ya 

que los jueces de dicho concurso revisarían minuciosamente el modelo, para ello es 

necesario que puedan acceder al mismo. Ya nos advierte Gubernm sobre los mensajes 

oculto para la mirada neófita: 

“Pero en contraste con esta función de la imagen como doble ostensivo, como 

simulacro y como imitación realista, nos encontramos también con otra tradición 

no extinguida de la imagen críptica,  como símbolo intelectual y como laberinto, 

una tradición hermética cultivada por el simbolismo del arte paleocristiano, por los 

alquimistas, por las sociedades secretas y por  los códigos pictográficos de mucho 

profesionales actuales (arquitectos, ingenieros, geólogos, meteorólogos, etc.), que 

constituyen verdaderos sociolectos icónicos cerrados de estas nuevas hermandades 

profesionales que han remplazado, en parte, a las sociedades secretas de 

antaño”92.  

 Solo las personas entendidas de estas temáticas pueden decodificar las propuestas 

profundas de dicho modelo, distinguir entre la realidad y su proyección virtual, en el valor 

de las imágenes simulacrales en relación a su viabilidad constructiva, aquí si son una 

referencia de lo real, y no solo una imagen que oculta la realidad.  

 

  

Imagen 74: Visualización tridimensional del modelo en la Galería 3D. 
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La visualización tridimensional de estos modelos puede ser llevado hasta una 

realidad virtual global a partir del Google Earth, que combina información de 

posicionamiento geográfico con múltiples capas temáticas, puede ser el relieve 

topográfico, las carreteras, fotografías de sitio, información turística y la capa de la 

arquitectura simulada le otorga valores tridimensionales a este sistema que parece muy 

plano y que necesita ser llenado por los modelos tridimensionales, ya que representar el 

entorno desde una fisión fotográfica parece muy caótico y ambiguo. Es por ello que 

parece fundamental la presencia tridimensional del artificio humano de lo construido,    

"la arquitectura es probablemente un engaño, una fantasía provocada por el deseo 

de localizar, la obsesión por la integración general de una auto interpretación del mundo 

cotidiano que nos rodea. Un intento imposible de racionalizar lo irracional"93, de esto se 

trata el Google Earth, organizar, sistematizar, representar, copiar, realizar en pocas 

palabra un modelo del mundo, donde solo exista la imagen para ser recorrida, consumida 

espacialmente, donde la imagen no tiene fin y “… [el usuario] está físicamente fuera de la 

pantalla, pero esta vicariamente en el interior de su espacio [simulado]…” y donde “… vive 

una ilusión de libertad, en el seno de un laberinto diseñado por otros y con sus opciones 

perfectamente predeterminadas”94, es un mundo para ser explorado, para leerlo, para 

mirarlo, donde la vida se reduce a una experiencia estética semiótica. 

 

 

 

 

 

 
Imagen 75: Información multiniveles en 

Google Earth. 

                                                           
93

 Zellner, Peter (2001). “Ruminations on the Perfidious Enchantments of a Soft. Digital Architecture Or: How 
I Learned to Stop Worrying Love the Blob”. En Digital/Real: Blobmeister, fisrt built projects. Berlin: 
Birkhäuser, p.p. 37. 
94

 Guberm (1999), p.p. 153. 
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El ciberespacio no existe para ser habitado, sino para ser recorrido, es decir, 

comparece como un espacio transitorio y efímero, es percibido como un fluido, en el que 

se navega, no se camina95, nos hace sentir como superhombres, nos da la iniciativa de 

esta narrativa discontinua, de este montaje cinematográfico, a esta aventura topográfica. 

Y es aquí donde mi propuesta se suma en esta realidad de participación, cada foto, cada 

modelo, cada información la aporta la gente, para la gente, el usuario no solo consume 

sino crea sus propias narrativas rizomáticas.  

 

 
 Imagen 76: El modelo Tlachtli en Google Earrth. 

 

1.3 Fotografías digitales 
 

Las fotografías digitales es un tema muy interesante y apasionante, se incrusta en la 

comunicabilidad del diseño con los clientes, y habla de asepsia en su técnica, de claridad 

en el mensaje visual y de seducción de la mirada, “los profesionales de la fotografía 

arquitectónica tienden a presentar la arquitectura como una forma de arte idealizado: 

                                                           
95

 Guberm (1999), p.p. 167-168. 
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limpio, perfectamente alineado, con líneas verticales que van a encontrar  un cielo 

azul claro y sin el elemento de interferencia… es lo que comúnmente se conoce como 

‘porno arquitectura’”96, imágenes que parecen estar en el espacio neutro de la máquina, 

en una paz religiosa, a lo mejor en el nirvana tecnológico o en la meditación energética. 

 
Imagen 77: Render foto realista del modelo Tlachtli. 

 

Sin embargo, también se vale ensuciar la imagen santificada de los renders y 

contextualizarlas en los ambientes sucios de la realidad, donde las habilidades 

interpretativas del diseñador ponen en juego su conocimiento pictórico. 

  
Imagen 78: Fotomontaje del modelo en el sitio específico. 

                                                           
96

Cachola Schmal, Peter (2001). “Digital >> Real: Proceedings in the Transfer of Architectural Visions”. En 
Digital/Real: Blobmeister, fisrt built projects. Berlin: Birkhäuser, p.p. 11. 
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 Finalmente las posibilidades de las fotografías digitales no se agotan, ya que el 

modelo tridimensional ofrece un sin número de puntos de vista donde su pueden realizar 

tomas fragmentarías de la propuesta, así como las tomas fotográficas digitales que 

también virtualizan la obra real. 

  
Imagen 79: Vista ascendente desde el interior del modelo. 

 

  
Imagen 80: Fotografía digital del refugio terminado. 
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1.4 Video 
 

Los puntos de vista fragmentarios que nos ofrece el CAD, son recogidos y secuenciados en 

el video, narración de un proyecto desde su origen hasta su culminación, nos permite 

rememorar de manera continua todos los momentos entrañables de esta propuesta, 

gracias a “La unidad del lenguaje cinematográfico [que] es el plano, que representa una 

porción del espacio virtual, a lo largo de una duración  que es en cambio real. Pero el 

montaje de los diferentes planos que componen la película genera un flujo diegético de 

enorme labilidad o versatilidad espacio-temporal, en el que lo discontinuo es percibido 

generalmente como continuo. De manera que el desarrollo de técnicas del montaje, que 

con su discontinuidad permitían cambiar el punto de vista o la escala de los planos en el 

interior de una escena, o trasladarse a escenas alejadas en el espacio y/o tiempo, permitió 

emancipar al cine de muchas de sus primitivas servidumbres teatrales”.97 

 
Imagen 81: Fotogramas del video documental Tlachtli 

http://www.youtube.com/dJAoSysgvmo  

                                                           
97

 Guberm (1999), p.p. 114-115. 
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2. Materiología 

 

La materiología es el conocimiento y manejo interdisciplinario de los materiales donde 

intervienen en su elaboración la “física, química, ingeniería, procesos industriales, diseño, 

informática, arte contemporáneo y mercadotecnia. ‘Dagognet habla de cuatro etapas en 

la creación de materiales conforme a modelos: etapa en los que se recurría a modelos 

naturales, etapa de copiado, etapa de modificaciones relativas y etapa de síntesis 

(sintéticos)’98… Esta artificialidad está construida en una dimensión microscópica y tiene 

intereses efectistas de simulación “… la verdadera dimensión de la simulación es la 

miniaturización genética. Lo real es producido a partir de células miniaturizadas, de 

matrices y de memorias, de modelos de encargo… y a partir de ahí pueden ser 

reproducidos un número indefinido de veces. No posee entidad racional al no ponerse a 

prueba en proceso alguno, ideal o negativo. Ya no es más que algo operativo que ni 

siquiera es real puesto que nada imaginario lo envuelve.”99   

Los materiales sintéticos han tenido un impresionante desarrollo, por ejemplo los 

polímeros son capaces de simular pieles de leopardo en una bolsa femenina o gemas en la 

joyería,  “Comenzamos a estar invadidos por una artificialidad sorprendente que abra de 

convertirse en nuestra neo-natura. Esos cuerpos provienen tanto del reino animal como 

del orgánico: la vieja separación física y metafísica que siempre los distinguía se vino 

abajo”100, sin embargo este proceso de simulación nos lleva a crear materiales con sus 

propias cargas significativas,  “Aquello que toda una sociedad busca al continuar 

produciendo, y superproduciendo, es resucitar lo real que se le escapa. Por eso, tal 

producción «material» se convierte hoy en hiperreal. Retiene todos los rasgos y discursos 

de la producción tradicional, pero no es más que una metáfora. De este modo, los 

hiperrealistas fijan con un parecido alucinante una realidad de la que se ha esfumado todo 

el sentido y toda la profundidad y la energía de la representación.”101 

                                                           
98

 Pérez (2003), p.p. 82. 
99

 Budrillard (1978), p.p. 7-8. 
100

 Pérez (2003), p.p. 82. 
101

 Budrillard (1978), p.p. 49. 
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2.1 Materiales artificiales 

 

Bien, ahora analizaremos los materiales de nuestro proyecto, el primer material que 

trataremos es la tabla de concreto, que tiene el nombre comercial de Durok o Permabase, 

aquí su tabla de ingredientes:102 

 

 Es un material complejo, donde se combinan materiales orgánicos y artificiales, 

para otórgale propiedades plásticas de flexibilidad utilizadas en la arquitectura actual para 

simular paredes que han perdido su función estructural, pero que mantienen sus 

cualidades visuales y plásticas, su textura y color es la misma del cemento es una metáfora 

del antiguo muro103. 

 
Imagen 82: Recorte de los paneles de tabla concreto en formas hexagonales. 

 

                                                           
102

 USG México (2005). Hoja de datos de seguridad de materiales: Tabla marca DUROK. 9 p.p. Consultado el 
20 de noviembre de 2009 en http://www.usg.com.mx/recursos/MSDS%20TABLACEMENTO.pdf, p.p. 1. 
103

 Anexo 2: Proyecto presentado al FOECA Guerrero en octubre del 2009, p.p. 5. 
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Hablaremos también de otro material artificial, el acrílico, este es un material 

diseñado por la tecnociencia de la química, con uno de sus productos estrella los acrilicos, 

“Los acrilatos son una familia de polímeros que pertenece a un tipo de polímeros vinílicos. 

Los poliacrilatos derivan obviamente de monómeros acrilatos y a su tiempo explicamos 

qué eran éstos. Los monómeros acrilato son ésteres que contienen grupos vinílicos, es 

decir, dos átomos de carbono unidos por una doble ligadura, directamente enlazados al 

carbono del carbonilo”104, en esta cita técnica observamos la desarticulación de la realidad 

por medio de la ciencia para reformarse en una nueva realidad absolutamente artificial, 

aquí el plástico transparente y translucido 

busca imitar las cualidades visuales de los 

vidrios tan propios de la arquitectura 

vernácula en Taxco, otorgarle un carácter 

con identidad taxqueña, pero a la vez 

integrando una solución de hiperrealidad 

contemporánea. 

  
Imagen 83: Aplicación del acrílico en el refugio. 

                                                           
104

 Grassino, Susana. Poliacrilatos. Consultado el 3 de junio de 2011 en http://pslc.ws/spanish/acrylate.htm. 
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2.2 Materiales naturales 

 

Nuestro primer material natural es la madera, que parte de la fragmentación de un 

sustrato orgánico obtenido del tronco de los arboles, para después transformarlo a partir 

de un modelo geométrico surgido de un pensamiento ingenieril, con objetivos 

constructivos y eficientistas. El material modificado simula a los modelos matemáticos, 

con medidas estandarizadas y forma cuadrangular. Sin embargo, se propuso la 

reutilización de cimbra usada, que nos lleva a los procesos de simbolización a posteriori105, 

donde el material está cargado de significado,  a lo mejor es un material utilizado en el 

cuarto del hijo de alguien, pero lo obsequian a un proyecto como esta para dejar su 

impronta en el espacio público. 

 

 

Imagen 84: La utilización de la madera como modelo 

constructivo y tradicional en Taxco. 

 

 

 

 

Imagen 85: Recolección del material donado. 

                                                           
105

 Pol (1995),p.p. 10 “Hablamos de simbolismo 'a posteriori' cuando nos referimos a aquellos espacios u 
objetos que juegan un papel activo en el mundo referencial de una colectividad, a partir del significado que 
a través del tiempo y del uso ha ido adquiriendo para cada una de las personas individualmente y para el 
grupo social como conjunto; aquellos espacios que a partir de la interacción entre las personas han 
devenido lugares comunes, cargados de significados y que actúan como elementos vertebradores de la 
comunidad.” 
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Imagen 86: Restauración del estanque en las instalaciones de la ENAP Taxco. 

Finalmente el agua,  elemento simbólico en la región y del sitio especifico106, del cual 

sufren su escases los taxqueños de hoy, pero que los ancianos recuerdan como un liquido 

abundante en fuentes y lavaderos, espacios públicos donde se ritualizaba la vida civil. 

 

 

 

 

 

Imagen 87: Fotografías del siglo pasado de 

Lavaderos públicos de Guadalupe, Taxco de 

Alarcón. 

                                                           
106

 Crimp, Douglas (2001). “La redefinición de la especificidad espacial”. En Paloma Blanco, Modos de hacer: 
arte crítico, esfera pública y acción directa. Salamanca: Universidad de Salamanca. 
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3. Objetología 

 

La objetología es el conocimiento y manejo de “saberes, oficios, procesos industriales, 

tecnológicos y materiales… [donde las] lógicas, estrategias, métodos y procedimientos que 

se articulan en la producción de objetos, cuya sofisticación es cada vez más evidente. 

Debajo de su contundente apariencia, los objetos contienen procesos industriales, 

tecnológicos, relaciones sociales, necesidades humanas, investigación científica, formal y 

de diseño, elementos artísticos, mercadotecnia y redes de producción, distribución y 

consumo que los hacen posible. Los objetos son inseparables de quienes los producen y 

de quienes los utilizan. Recorren diferentes procesos de elaboración, tienen varias 

dimensiones  componentes y reúnen saberes y conocimientos que no son evidentes para 

quienes los analizan, fuera de la relación que guardan con el hombre, la cultura, el mundo 

de la producción y los demás objetos de su época.  

Separados de sus semejantes (las cosas, los productos, los artículos), los objetos 

son el resultado de un trabajo muy complejo de tipo interdisciplinario, en el que 

intervienen cada día más nuestro profesional del diseño.”107, todo esto se expresa en el 

objeto en forma artística de signo-mercancía, la cual “deviene en hipermercancía… es 

decir, que ya no está ligada a intercambios distintos o a necesidades determinadas, sino a 

una especie de universo total de los signos, o de circuito integrado que un impulso recorre 

de parte a parte, tránsito incesante de opciones, de lecturas, de referencias, de marcas, de 

descodificación.”108. 

  
Imagen 88: Fragmento del refugio. 

                                                           
107

 Pérez (2003), p.p. 83. 
108

 Baudrillard (1978), p.p. 88-89. 
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3.1 Objeto de la mirada 
 

El objeto que proponemos es una hibridación de las dimensiones semióticas y 

simbólicas, las semióticas vienen ligadas a una serie de significados surgidos del origen 

toponímico del lugar y su función actual, “tlacht que se traduce como juego de pelota y el 

locativo -co que significa [en Nahuatl] en o el lugar. Sin embargo en la ciudad de Taxco no 

encontramos un campo del juego de pelota antiguo, tampoco algún elemento 

tridimensional que pueda atizar el imaginario colectivo y la identidad precolombina de sus 

habitantes en torno a su toponimia, solo encontramos un resabio en el logotipo utilizado 

por las administraciones municipales, reproducido innumerables veces en el mobiliario 

urbano y en algunos mosaicos de las calles.”109 A partir de este análisis toponímico es que 

se plantea el objeto pelota110, desplazando la geometría de los balones de futbol a este 

sitio específico de intervención artística, generando una imagen icónica que simula ser un 

balón, es un objeto para ser mirado, es un indicio de que estamos en el lugar de las 

pelotas, Tlachco. 

 
Imagen 89: Vista exterior del refugio. 

                                                           
109

 Anexo 2: Proyecto presentado al FOECA Guerrero en octubre del 2009, p.p. 2. 
110

 Anexo 2: Proyecto presentado al FOECA Guerrero en octubre del 2009, p.p. 1. 
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El sistema constructivo es un elemento más que se plantea con estas dos 

dimensiones, es decir la cimbra que está cargada de elementos simbólicos, ya que en 

Taxco “El testimonio de nuestra cultura popular, conserva materiales y sistemas 

constructivos regionales de gran adecuación al medio, por lo que constituye un 

patrimonio enorme y de vital importancia, que debe ser rescatado, protegido… 

conservado”, lo cual posibilitará la inclusión de este sistema tecnológico como el eje 

discursivo de pertenencia social, y que busco renovarlo a través de la inversión del 

sistema, es decir, en vez de formar una estructura que funcione como molde de un 

vaciado matérico, aquí lo propongo como un molde del espacio contenido en su interior. 

 
Imagen 90: Perspectiva del refugio. 
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3.2 Objeto para usarse 
 

 
                Imagen 91: Casa de árbol de Sanei Hopkins.            Imagen 92: Sea Suite de Xavier Claramunt. 

Este objeto fue diseñado como refugio climático, su objetivo primordial era proteger 

contra la lluvia, el sol y el viento, un tema de siempre presente en los proyectos de 

habitación humana, desde las cavernas a hasta las estaciones satelitales son “… los 

proyectos [que] instauran una mirada sobre lo primigenio y fundamental: la vivienda 

como un refugio que se adapta a las necesidades básicas del habitante, partiendo de la 

ludicidad, mediante el uso de sofisticados diseños que aprovechan los avances 

tecnológicos para volver a los orígenes”111, lugares para vivir, comer, estudiar, platicar, 

convivir y protegernos. 

   
Imagen 93: Refugio urbano nómada de Electroland. 

                                                           
111

 Broto, Eduard (2010). Microarquitectura: creatividad y diseño. Barcelona: Link, p.p. 7. 



85 
 

         

             Imagen 94: Oficina H-3 de Winfried Buamman                             95: Dream House de X-Studio 

Las necesidades de vida actual crean tendencias en la micro arquitectura donde la 

creatividad y el diseño exploran maneras diferentes de solución a las necesidades 

humanas de habitar la contemporaneidad, “Espacios cada vez más reducidos o ´mini 

espacios´ que cohabitan con estilos de vida menos reposados y móviles, generan nuevas 

respuestas y soluciones para estilos de vida temporales, refugios de emergencia, casas 

´hágalo usted mismo´, hasta aquellas para usuarios epeciales (estudiantes, casas para 

madres solteras, trabajadores estacionarios, etcétera). Aún como proyectos 

experimentales, tendencias de escuelas y también tomando en cuenta trabajo de artistas 

contemporáneos…”112, como en este refugio donde su propone un aislamiento del 

mundo, una guarida para estudiar, un lugar para escapar, meditar, discutir y estar en paz. 

 
Imagen 96: Pareja de estudiantes entrando al refugio. 

                                                           
112

 Broto (2010), p.p. 204. 
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El refugio es concebido como lugar de sosiego para el que llega, se recupera la 

atmosfera templada de la Ex Hacienda del Chorrillo, debido a que hoy en día las calles de 

Taxco ya no  tiene casi arboles y la gran 

cantidad de autos hacen de sus calles 

lugares muy calientes, aquí pueden llegar 

a refrescarse. También recupera la escala 

humana tan olvidada por la nueva 

arquitectura monstruosa donde las masas 

ritualizan el consumo capitalista, la 

concepción intimista del espacio invita a 

concentrarse, meditar y relajarse.       Imagen 97: Escala humana del refugio 

Finalmente esta intervención urbana tiene otra dimensión la de observatorio, en la 

cual se ofrece la posibilidad de conectar al usuario con la naturaleza mediante sus doce 

ventanas pentagonales, desde donde se observa el entorno natural del sitio, con una 

visión poli angular y fragmentaria, cada ventana enmarca una vista, ninguna se repite, es 

un sentimiento de pertenencia al mundo que a la vez nos separa de él, parece que solo a 

través del artificio podemos concientizarnos de que estamos en la Tierra. 

 

 
Imagen 98: Vista cenital ascendente un día lluvioso desde el interior del refugio.  
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3.3 Objeto apropiado 

 

El universo significante de los objetos propicia “El estudio del sistema “hablado” de los 

objetos, es decir, del sistema de significados más o menos coherente, que instauran, 

supone siempre un plano distinto de este sistema “hablado”… A partir de esta lengua, de 

esta coherencia del modelo técnico, podemos comprender qué es lo que les ocurre a los 

objetos por el hecho de ser producidos y consumidos, poseídos y personalizados.”113 Esta 

posibilidad de personalización es una facultad humana que se encuentra “En el ciclo vital, 

en las primeras etapas hasta la madurez, prima la acción sobre la identificación. En la vejez 

prima más la identificación que la acción-transformación, aunque ambas están siempre 

presentes. Así, el simbolismo del [objeto] socialmente construido deviene un factor de 

estabilidad de la identidad individual y colectiva, a la vez que un factor de cohesión de 

grupo.”114, un ejemplo de esta personalización y simbolización de los objetos son las 

innumerables esculturas en el espacio público firmadas por la sociedad civil, 

envolviéndolas en un espectáculo multicolor propio de nuestra época, donde el usuario-

ciudadano quiere ser escuchado y se expresa sobre los objetos del espacio público. 

 

              Imagen 99: Muro Articulado Herbert Bayer         Imagen 100: Sol Bípedo de Pierre Székeli 

                                                           
113

 Baudrillard, Jean (1969). El sistema de los objetos. México: Siglo XXI, p.p. 3. 
114

 Pol (1999), p.p. 5. 
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 Así, esta propuesta de refugio que interviene el espacio público de Taxco, donde 

los estudiantes, profesores y visitantes (turistas y ciudadanía taxqueña) tienen acceso 

total en tiempo y espacio a la obra. Es un espacio donde se han dado clase, donde la 

comunidad se reúne a compartir, un espacio para los solitarios, un espacio que invita a ser 

intervenido por los usuarios, un lugar donde pueden dejar su impronta , un objeto para 

ser apropiado a partir de su simbolización a posteriori115. Así se planteo esta propuesta 

como un objeto-espacio capaz de generar procesos de apropiación a través de la 

participación ciudadana en la donación de la madera para la estructura, y que en la 

imagen siguiente observamos una huella dejada por algún estudiante, profesor, artista, 

visitantes o alguien más, mediante esta intervención de arte esténcil.  

 

Imagen 101: Interior del refugio.  

                                                           
115

 “Hablamos de simbolismo 'a posteriori' cuando nos referimos a aquellos espacios u objetos que juegan 
un papel activo en el mundo referencial de una colectividad, a partir del significado que a través del tiempo 
y del uso ha ido adquiriendo para cada una de las personas individualmente y para el grupo social como 
conjunto; aquellos espacios que a partir de la interacción entre las personas han devenido lugares comunes, 
cargados de significados y que actúan como elementos vertebradores de la comunidad”. Pol (1999), p.p. 11. 
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Conclusiones 

 

 El arte contemporáneo es un animal que se abre paso por todos lados invadiendo 

cualquier realidad, y la Ciudad de Taxco no es excepción, intervenida por 

ciudadanos, empresas y gobiernos cada día podemos identificar, describir y 

enunciar una tendencia actual hacia una estética de la simulación, donde nada es 

lo que parece ser, es un montaje escénico sobre una realidad olvidada, la colonial, 

envuelta en el engaño del sustituto contemporáneo que vacía de significado y que 

nos deja solo con las apariencias, con las sombras de la cueva de Platón, con un 

simulacro de realidad, con la hiperrealidad. 

 

 La elección de un sito específico rico en historia, cultura, actividades y entorno 

físico, como la Ex Hacienda del Chorrillo, posibilita y potencia la creatividad 

artística contemporánea, ya que como hemos comentado sus características 

complejas multiniveles, pluridimensionales,  polimórficos, policéntricos, 

autorreguladores y polisistémicos son los insumos de los cuales la fantasía se 

nutre, por ello concluyo que el lugar elegido para este proyecto generó una 

conjunto de significados, experiencias y soluciones que se tradujeron en 

expresiones artísticas contemporáneas. 

 

 En este trabajo fue fundamental la caracterización y metodología de creación y 

estudio que Francisco Pérez Cortes nos ofrece en su libro en su libro “Lo material y 

lo inmaterial en el arte-diseño contemporáneo”, ya que parte de un contexto 

actual y de las prácticas profesionales del arte y el diseño contemporáneo, con lo 

cual se hace un estudio más completo e integral del proyecto, donde se consideran 

lo científico, lo estético, lo comunicativo, lo tecnológico, los social y lo psicológico 

desde tres diferentes puntos de vista, los lenguajes virtuales, la materiologia y la 

objetologia.  
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 Los lenguajes virtuales son diversos, hoy no solo se habla de la realidad virtual (RV) 

como tal, hay que considerar también el trabajo con programas de diseño asistido 

por computadoras que generan interpretaciones (renders) fotográficos fijos o 

secuenciales, que a la postre son trabajados por editores de fotografía y video, los 

cuales producen virtualidades diferentes y complementarias de la RV. 

 

 Desde la materiología podemos hablar de que nos encontramos transformando 

nuestro entorno en una nueva realidad llamada por Francisco Pérez neo-

naturaleza, los seres humanos contemporáneos estamos ajenos a la naturaleza 

orgánica del mundo, hoy día nos sentimos más en casa dentro de espacios 

formados con materiales artificiales, artificios producto de la transformación 

científica e ingenieril de la materia, en donde también encontramos un simulacro 

de la realidad, con materiales contemporáneos como la tabla de concreto o los 

vidrios plásticos. 

 

 Finalmente en el tema de la objetología puedo concluir que mi propuesta “Tlachtli 

–Pelota” es una obra de arte contemporánea al ser un objeto híbrido, al contener 

diversas funciones: refugio, observatorio y espacio para el estudio y la meditación, 

también por la evolución que desarrolla de una figura geométrica arquimediana 

(icosaedro truncado) a una construcción compleja en expresiones artísticas, es una 

imagen icónica de un balón, es una intervención artificial en el entorno “natural”, 

es una obra abierta a resignificarse a través del publico-usuario.  
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On the occasion of the exhibitions Frank Lloyd Wright: 
From Within Outward and Learning By Doing, the 
Guggenheim and Google SketchUp invite amateur and 
professional designers from around the world to enter 
Design It: Shelter Competition. From now until August 23, 
you can submit a 3-D shelter for locations around the world 
using Google SketchUp and Google Earth.

Why shelters?
The competition is an extension of Learning By Doing, an 
exhibition in the Guggenheim Museum Sackler Center 
for Arts Education that features plans, photographs, and 
models of student-built shelters from the Frank Lloyd 
Wright School of Architecture. For the past seven decades, 
students at this school have taken on the challenge of 
designing, building, and living in small shelters nestled 
in the landscapes of the school’s Arizona and Wisconsin 
campuses. In working on these shelters, students consider 
human needs for safety and comfort, as well as the 
relationship between architecture and place.

Design It: Shelter Competition opens up the project to 
you. If you could build a shelter anywhere in the world, 
where would it be? How would you design it to respond  
to the surrounding environment?

Key Dates and Deadlines
Submission period:  
 June 8—August 23, 2009 
Ten People’s Prize finalists selected:  
 September 7, 2009 
People’s Prize public voting period:  
 September 7—October 10, 2009 
People’s Prize and Juried Prize winners announced:   
 October 21, 2009

Accept the Challenge
Find out more about how to enter the competition.

Competition guiDelines
In celebration of the ideas and teaching of Frank Lloyd 
Wright, the Guggenheim Museum invites you to create 
your own virtual shelters, located anywhere on Earth. 
Share your design on the Guggenheim’s Web site by first 
modeling your shelter with Google SketchUp, then placing 
your model on Google Earth.

When designing your shelter, consider Frank Lloyd Wright’s 
interest in the connection between architecture and its 
location. How can your shelter respond to the specific 
natural and built environments that surround it?

project specs
Location
You can build your shelter anywhere on Earth: from city 
to desert, hill to valley. You cannot remove any existing 
buildings, but you can add on to existing structures.

Size
Keep your shelter small—it can be no larger than 100 square 
feet (9.3 meters), and entire shelter no taller than 12 feet 
(3.6 meters).
Amenitites
Your shelter must offer protection from the elements and 
provide a space for one person to study and sleep. Keep it 
simple—no water, gas or electricity allowed.

How to enter
To enter the contest, submit the following:

SketchUp model of your shelter (view the  1. 
SketchUp tutorial page for instructions).

Design it: sHelter Competition 
submission guiDe

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/how-to-enter
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/sketchup-tutorial 
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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A written description (in English) of your shelter and 2. 
how it integrates into the location where you placed it 
(limited to 70 words).

SketchUp animation showing the inside and outside  of 3. 
your shelter. (The animation is optional. Keep in mind, 
though, that in Google Earth, viewers will only be able 
to see the outside of the shelter—an animation is a great 
way to present a more detailed interior view of your 
design.)

Images of your shelter (1–4 JPEGs, at least 235 pixels 4. 
wide but no larger than 720 pixels wide).

Once all your materials are ready, you must fill out the 5. 
submission form. 

submission form / tips
Complete the submission form and enter all required 
information as indicated with an asterisk below (unmarked 
items are optional). 

first name*
last name*
e-mail address*
City where you reside*
Country where you reside*
Age* (Must be 13 years or older as of June 8, 2009)

shelter title* (Limited to 40 characters)

shelter Description* (Limited to 70 words)

google 3D Warehouse model link* 
After you’ve uploaded your SketchUp model to the 
Google 3D Warehouse, you need to tell us where it is by 
providing the web address for your model. You can find this 
by selecting the Link button at the bottom of your model’s 
page in the 3D Warehouse. Copy the long string of text 
that appears, then paste it into this submission form. How? 

Country where your shelter is located*
upload image of your shelter* 
You can export images of your model from SketchUp to 
show specific views that you want people to see. How? 

To enter this competition, you must upload at least one 
(and up to four) images of your model. These images must 
be JPEGs, and must be at least 235 pixels wide but no 
larger than 720 pixels wide.

upload 2nd image of your shelter 
You can export images of your model from SketchUp to 
show specific views that you want people to see. How? 

To enter this competition, you must upload at least one 
(and up to four) images of your model. These images must 
be JPEGs, and must be at least 235 pixels wide but no 
larger than 720 pixels wide.

upload 3rd image of your shelter
upload 4th image of your shelter
Youtube Video url 
If you’ve created a video of your model that you’d like to 
include with your competition entry, you can upload it to 
YouTube. The YouTube Video URL is the Web address for 
your video on YouTube. You can find it on your video’s Web 
page. How do I export an animation from SketchUp? 

To enter, you must be 13 years or older as of June 8, 2009. 
All entries must be in English. In order to be eligible for a 
prize, your entry must be uploaded into the Google 3D 
Warehouse. To upload your model to the 3D Warehouse 
you must create a Google Account. Sign up for a Google 
Account.

google  sKetCHup introDuCtion  
AnD oVerVieW
Google SketchUp is software that you can use to build 
virtual 3-D models of anything you like. It’s free, available 
in a number of different languages, and relatively easy to 
learn. You can download Google SketchUp and start using 
it right away.

The shelter models you submit for this competition need to 
be uploaded from Google SketchUp (where you can create 
them) to the Google 3D Warehouse. This is a huge, online 
repository of SketchUp models contributed by people all 
over the world.

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/support/bin/answer.py?answer=37939&cbid=-f2y4lzm8778c&src=cb&lev=answer
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=114296
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=114296
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=114335
https://www.google.com/accounts
https://www.google.com/accounts
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to get stArteD Here’s WHAt You neeD 
 to Do

Download Google SketchUp and Google Earth for free. 1. 
Both are available for both Windows and Macintosh 
computers.

Use Google SketchUp to design a shelter for a 2. 
particular location on the planet. Give your model a 
precise geographic location with Google Earth.

Upload your geographically-located SketchUp shelter 3. 
to the Google 3D Warehouse.

Copy the web address for your shelter model from the 4. 
Google 3D Warehouse and paste it into the entry form 
for this competition.

Export at least one (and as many as four) views of your 5. 
model as JPEG images and upload them when you’re 
submitting your entry.

Export an animation of your shelter as a video and 6. 
upload it to YouTube, then copy and paste the YouTube 
video URL into the entry form. This is optional, but 
strongly encouraged.

Instructions for doing all of the above things are included in 
the rest of this PDF. Additional information is available in 
the Help Centers for Google SketchUp and Google Earth:

Google SketchUp Help Center

Google Earth Help Center

DoWnloADing AnD instAlling google 
sKetCHup
Google SketchUp is software that you download onto your 
computer; it doesn’t run in a web browser like many of 
Google’s other applications.

To download Google SketchUp:

Visit http://sketchup.google.co1. m

Use the Download Google SketchUp button in the 2. 
upper-right corner of the page.

Use the Download Google SketchUp 7 link on the page 3. 
that appears.

Note: You can download and install the Pro version of Google SketchUp if 
you like, but the Free version is all you need to design, model and upload a 
shelter for this competition. If you download the Pro version and decide not 
to buy a license to activate it, it will revert to the functionality of the Free 
version after the trial period has elapsed.

Choose the operating system on which you’d like to run 4. 
Google SketchUp (Windows or Mac OS X).

Accept the terms of the license agreement by selecting 5. 
Agree and Download, then start the download to your 
computer.

to instAll google sKetCHup on Your 
Computer (After You’Ve DoWnloADeD it)
Windows computers

Log in to the computer with a user account that has 1. 
administrator rights.

Double-click on the EXE install file that you 2. 
downloaded. On Windows Vista, right-click and select 
Run as an administrator.

Select Next in the Welcome dialog box.3. 

You may be asked to install the .NET Framework at this 4. 
point. This software is required for Google SketchUp 
Pro.

Note: If you’re asked to reboot after installing the .NET Framework, please 
do so. To resume installing SketchUp, double-click on the SketchUp install 
file after your computer reboots.

Select the “I accept the terms of this license agreement” 5. 
button in the End User License Agreement if you agree 
to the terms.

Select the Next button to install SketchUp in the default 6. 
location.

Select the Install button if you’re satisfied with the 7. 
settings.

Select the Finish button when prompted.8. 

Launch Google SketchUp once before logging out of 9. 
the administrative user account.

macintosh computers
Log in to the computer with a user account that has 1. 
administrator rights.

Double-click on the DMG install file that you 2. 
downloaded. This will mount an installer drive and 
launch a Finder window.

Double-click on the “.mpkg” file. This will launch the 3. 
installer window.

Select Continue in the Introduction section.4. 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/support 
http://earth.google.com/support 
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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If you accept the Software License Agreement, select 5. 
the Continue button, then click Agree.

Select the destination for the installation and select 6. 
Continue.

Select the Install button. You may be prompted for 7. 
your administrator account password to authorize the 
installation.

When the installation completes, select the Close 8. 
button.

leArning to mAKe moDels WitH  
google sKetCHup
The best way to get started with Google SketchUp is to see 
it in action. Many, many good training videos are available 
online for free; here’s where to find some of them:

Official SketchUp Video Tutorials

Go 2 School

Concept3D

Google SketchUp For Dummies

Another great source of information is the SketchUp  
Help Center:

Google SketchUp Help Center

DoWnloADing AnD instAlling google 
eArtH
The procedure for downloading and installing Google 
Earth on your computer is very similar to the one for 
Google SketchUp. To get the latest version (5) of Google 
Earth, visit: http://earth.google.com

leArning to use google eArtH
The best way to get started with Google Earth is to visit 
the Introduction section of the online Google Earth User 
Guide. Of particular interest are the instructions for 
navigating around inside Google Earth:

Using a Mouse

Using the Navigation Controls

builDing A sKetCHup moDel WitH A 
preCise geogrApHiC loCAtion
To give a SketchUp model a precise location in  
Google Earth:

Open Google SketchUp.1. 

Open Google Earth.2. 
Note: For best performance, make sure SketchUp is running before you 
start Google Earth; otherwise, SketchUp might run slowly.

In Google Earth, turn on 3D terrain. To do this, select 3. 
the “Terrain” check box in the Layers list on the left side 
of the screen.

Note: To ensure that the vertical position of SketchUp models you place 
in Google Earth is correct, set the Google Earth elevation exaggeration to 
“1”. In Google Earth, choose Tools > Options > 3DView > Terrain Quality 
and set “Elevation Exaggeration” = 1. (On a Mac, choose Google Earth › 
Preferences › 3DView › Terrain Quality). 

In Google Earth, use the navigation tools to frame a 4. 
top-down view of the location where you want to place 
your model.

Note: To get the best-possible image quality, make sure you’re zoomed in 
as far as you can be. Frame only as much land as you need to build your 
model.

To make sure you’re looking straight down at the ground, press “R” on your 
keyboard. Your camera will move to a top-down view, and your view will 
rotate so that North is at the top of your screen.

At this point, it’s a good idea to make sure the 3D Buildings layer (on the 
left side of your screen) is turned off.

In SketchUp, choose Tools › Google Earth › Get Current 5. 
View to import the section of terrain (and satellite 
imagery) that you framed in Google Earth in Step 3.  
A flat, black-and-white “snapshot” appears in the center 
of your SketchUp file.

Note: You can also use the Get Current View button to import a snapshot 
from Google Earth. The black-and-white Google Earth snapshot is used 
only for accurately positioning your model. It is not re-exported to Google 
Earth with the rest of your model.

In SketchUp, build a model on top of the Google  6. 
Earth snapshot you imported in Step 4.

Note: You can also import a Google Earth snapshot into a SketchUp file 
with an existing model. In this case, use the Move, Rotate and Scale tools to 
accurately position your existing model on the Google Earth snapshot.

You can also place a model from a separate SketchUp file into the file with 
the Google Earth snapshot.

In SketchUp, choose Tools > Google Earth > Toggle 7. 
Terrain to view the 3D version of your Google Earth 
snapshot. If the terrain in your snapshot is not flat, it 
appears as a 3D, sloped surface that reflects the 3D 
terrain in Google Earth.

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/training/videos.html 
www.youtube.com/4sketchupgo2school 
www.youtube.com/concept3Dmodeling 
www.youtube.com/aidanchopra 
http://sketchup.google.com/support 
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://earth.google.com/userguide/v4
http://earth.google.com/userguide/v5/#mouse 
http://earth.google.com/userguide/v5/#navcontrols 
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Note: When you import a Google Earth snapshot, two versions are actually 
added to your SketchUp file. The first is a flat surface that is easier to 
work with as you build or laterally position your model. The second is a 3D 
surface that you use to adjust the vertical position of your model. You can 
switch between the two versions of the Google Earth snapshot by choosing 
Tools > Google Earth > Toggle Terrain.

You can also use the Toggle Terrain button to switch between versions of 
the Google Earth snapshot.

In SketchUp, use the Move tool to adjust your model’s 8. 
vertical position relative to the 3D Google Earth 
snapshot. Your model should not be floating above the 
terrain, nor should it be sunken too far into the ground.

Note: To “lock” the Move tool so that you can only move in the vertical 
(blue) direction, press either the Up Arrow or Down Arrow key on your 
keyboard.

If something you’re trying to move in the blue direction won’t move in 
that direction, it might be glued. To unglue it, right-click on it and choose 
Unglue.

If you’re unable to get your model to sit on the Google Earth snapshot 
without having it float or be sunken too far underground, you might 
consider adding material to the bottom of your model. The terrain in 
Google Earth is not 100% accurate, so some adjustment of models in 
SketchUp is necessary to make them appear correct when they’re viewed  
in Google Earth.

In SketchUp, choose Tools > Google Earth > Place 9. 
Model to export your model to Google Earth. Google 
Earth becomes your active application, and your model 
appears on the terrain in the location you specified using 
the Google Earth snapshot.

At this point, the model you’ve placed in Google Earth is 
visible only on your computer—no one else can see it.  
To share it with other people, you have at least two options:

You can save it as a Google Earth KMZ file that you can 
email or otherwise send directly to other people.

You can upload it to the Google 3D Warehouse, where 
anyone you specify can download it onto their computer. 
If you want your model to appear by default in the 3D 
Buildings layer in Google Earth (so that it’s automatically 
visible to everyone in the world), this is the approach you 
need to take.
Note: You can also use the Place Model button to export your model to 
Google Earth.

uploADing A moDel to tHe google 3D 
WAreHouse
The Google 3D Warehouse is a searchable, online 
repository of 3D models.

Anyone can upload a model to the 3D Warehouse.

When you upload a model, you can specify who gets to see 
it. Models can be unshared, shared with specific people, or 
shared with the whole world.

Models in the 3D Warehouse are either geographically 
located (meaning they have a precise location on the 
Earth), or non-geographically located (meaning they do 
not). You can geographically locate a model by using 
SketchUp in combination with Google Earth.

Google 3D Warehouse

to uploAD A sKetCHup moDel to tHe 
google 3D WAreHouse:

In Google SketchUp, open the model you’d like to 1. 
upload to the 3D Warehouse.

Use SketchUp’s navigation tools (Orbit, Pan and Zoom) 2. 
to frame the view of your model that you would like to 
appear by default in the 3D Warehouse.

Choose File > 3D Warehouse > Share Model. A Google 3. 
Account “Sign in” page opens on your screen.

Note: If the “Upload your model to 3D Warehouse” page appears instead of 
the “Sign in” page, you (or someone else) is already signed-in to a Google 
Account. The name of the account appears at the top of the page. If you 
like, you can sign out of that account and sign in to a different one, then 
click the “Back” arrow in the upper-left corner to return to the Upload page.

Enter your Google Account username and password, 4. 
then Sign In. The “Sign in” page closes and the “Upload 
your model to 3D Warehouse” page opens.

Note: You need to have a Google Account to upload models to the 3D 
Warehouse. If you don’t have a Google Account, you can get one by 
selecting “Create an account now”.

Your Google Account login information is the same as your login 
information for any other Google product, including iGoogle, Gmail,  
Picasa Web Albums and Google Docs.

On the “Upload your model to 3D Warehouse” page, 5. 
enter the following information:

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/3dwarehouse/ 
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title
Give your model a title that’s descriptive and meaningful.

Description
Models with thorough and well-written descriptions are 
much more popular than models with short or badly- 
written ones.

tags
Tags are keywords or short phrases that describe your 
model. They make your models easier to find when 
someone is searching for something specific. Separate 
each tag with a comma (,) and try to anticipate what terms 
searchers might use to find models like yours.

If your model is geographically located, the “Upload” page 
includes these options:

Address
If your model is a building that has a street address, enter it. 
Your shelter probably doesn’t, though.

google earth ready
A “Google Earth Ready” model is one that is correctly 
geographically located and is an accurate depiction of 
the building or other structure that currently exists in 
that location. Unless your shelter actually exists as a built 
structure in the real world, don’t check this box. 

If you like, you can enter the following optional information:

Web site (optional)
If there’s a web page that contains more information 
about your model, paste in its URL. Typically, URLs look 
something like this: http://www.google.com

Add a logo (optional)
If there’s a logo image you’d like to associate with your 
model, you can. You can either choose an image file from 
your computer or paste in a URL for an image on the Web.

Allow anyone to view this model and see it in  
search results
Deselecting this check box allows you to specify who (if 
anyone) gets to view and/or collaborate on your model.  
For this competition, you must leave this checkbox 
selected; if you deselect it, no one will be able to see your 
entry.

show list of links for containing collections
Deselecting this check box hides the “Collections 
containing this model” area on your model’s Details page. 

You should choose this option if you don’t want visitors to 
see a list of collections that include your model.

Allow 3D Warehouse users to contact me about  
this model
Deselecting this check box hides the “Contact” button on 
your model’s Details page. You should choose this option 
if you don’t want to receive email from people about your 
model.

Select “Upload” to upload your model to the Google 6. 
3D Warehouse. Your model is uploaded and the 3D 
Warehouse Model Details page appears.

Select the Link button at the bottom of the page, then 7. 
copy the web address for your model. You’ll need it to 
fill out the entry form for this contest.

finDing Your moDel on tHe google 3D 
WAreHouse After You’Ve uploADeD it
You can get to the Google 3D Warehouse in two ways:

by visiting http://sketchup.google.com/3dwarehouse from 
any Web browser (such as Firefox, Chrome, Safari or 
Internet Explorer). 

By choosing File > 3D Warehouse > Get Models from the 
menu bar inside SketchUp

to finD All of tHe moDels You’Ve 
uploADeD to tHe 3D WAreHouse:

Sign in (if you haven’t already) using the same Google 1. 
Account information you used to upload your model(s).

Select the My Models link at the top of the page to see 2. 
a list of the models you’ve uploaded.

getting tHe Web ADDress for Your 
moDel After You’Ve uploADeD it
To enter this competition, you’ll need the Web address for 
your model in the Google 3D Warehouse. This is a link 
directly to your model on the Web.

Find your model in the Google 3D Warehouse. For 1. 
help, see the instructions above.

Make sure you’re on the page for the model whose 2. 
address you want to find.

Select the Link button at the bottom of the page, then 3. 
copy the web address that appears in the box below the 
button. It should look something like this:

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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http://sketchup.google.com/3dwarehouse/details?mid=asdf;
lk4h35oig7aogoshgh
Note: To copy, highlight the text and choose Edit > Copy from the  
menu bar.

exporting A Jpeg imAge from google 
sKetCHup
To export a view of your model as a JPEG image:

Manipulate the view of your model so that it appears 1. 
as you would like it to appear in the exported image. 
SketchUp will export the model view as it’s currently 
displayed, including display style, shadows, and point  
of view.

Select File > Export > 2D Graphic from the menu bar. 2. 
The Export 2D Graphic dialog box appears.

Enter a file name for the exported file in the “File name” 3. 
(Microsoft Windows) or “Save As” (Mac OS X) field.

Select “JPEG” as the export type from the “Export type” 4. 
(Microsoft Windows) or ‘Format’ (Mac OS X) drop-
down list.

Note: Selecting the “Options” button brings up a list of export options.  
For images that you plan to submit for this competition, leave the “Use 
View Size” checkbox selected.

Then select the Export button.5. 

exporting An AnimAtion (moVie) from 
google sKetCHup
You can export movies of your models from Google 
SketchUp that you can view on your computer, send to 
other people, or upload to video sharing Web sites like 
YouTube.

Before you can export an animation from Google 
SketchUp, you need to set up Scenes in your model. 
Scenes are a little bit like different camera views. When it 
exports an animation, SketchUp moves its “camera” from 
Scene to Scene, creating a smooth transition between the 
different views that you set up.
Note: Keep in mind that in SketchUp’s animations, only the camera moves; 
it’s not possible to create animations wherein individual objects within the 
model move.

to create scenes in your sketchup model:
Manipulate the view of your model so that it appears as 1. 
you would like it to appear in the Scene you’re about the 
create.

Note: Scenes can save more than just the camera position in your model. 
They can also save other properties such as shadow position, display style 
and field of view.

Choose View > Animation > Add Scene. A new Scene is 2. 
created, and a corresponding Scene tab is added at the 
top of your modeling window.

Note: To update, rename or delete an existing Scene, right-click its Scene 
tab to bring up a context menu of options. You can also add, delete and 
otherwise manage the Scenes in your model by using the Scenes Manager 
dialog box, which appears when you choose Window > Scenes from the 
menu bar.

Repeat Steps 1 and 2 for each new Scene you want to 3. 
create.

With Scenes created, you can export an animation (movie) 
from your SketchUp model:

Choose Window > Model Info from the menu bar. 4. 
When the Model Info dialog box appears, select the 
Animation panel from the list on the left.

Enter settings for Scene Transition and Scene Delay, 5. 
then close the Model Info dialog box.

Scene Transition
This is the amount of time it takes for SketchUp to move 
between consecutive Scenes.

Scene Delay
This is the amount of time that SketchUp will pause on 
each Scene before moving on to the next.

Choose File > Export > Animation from the menu bar. 6. 
The Export Animation dialog box appears.

Enter a file name for the exported file in the ‘File name’ 7. 
(Microsoft Windows) or “Save As” (Mac OS X) field.

Select AVI (Windows) or Quicktime Movie (Mac OS 8. 
X) as the export type from the “Export type” drop- 
down list.

Click the Options button to open the Animation Export 9. 
Options dialog box.

Enter the following settings to export an animation 10. 
video which you can upload to YouTube:

Width and Height: 
1280 x 720

Frame Rate: 
30 frames/second

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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Anti-alias: 
Yes

Select the Codec button (Windows) or the Expert 11. 
button (Mac OS X) to open the Compression dialog 
box. Enter the following settings to export an animation 
video which you can upload to YouTube:

Codec (Windows): 
Indeo Video 5.10

Compression Type (Mac OS X): 
H.264

Key Frame Every: 
24 frames

Compression Quality (Windows): 
50

Quality (Mac OS X): 
Medium

Select OK to close the Compression dialog box, then 12. 
OK to close the Animation Export Options dialog box.

Select Export to create your animation video file.13. 

uploADing An exporteD sKetCHup 
AnimAtion to Youtube
To upload your exported video to YouTube:

Make sure the video file you want to upload to YouTube 1. 
is no more than 10 minutes in length and less than 1GB 
in file size. If your video doesn’t fall within these limits, 
you’ll have to re-export a smaller or shorter video. Try 
re-exporting it using a smaller Frame Rate (20 fps is a 
good place to start).

Go to the YouTube Web site at www.youtube.com.2. 

Select the Upload button in the upper-right-hand corner 3. 
of any YouTube page.

Note: If you haven’t already, sign in to YouTube with either your Google 
Account (which you used to upload your model to the Google 3D 
Warehouse) or your YouTube account (if you have one).

Use the “Browse” button to browse for the video file 4. 
you’d like to upload to the site. Select the file you want 
to upload.

Select the “Upload Video” button to start the uploading 5. 
process.

As the video file is uploading, enter as much information 6. 
about your video as possible in the relevant fields 
(including Title, Description, Tags, and Category). 
You’re not required to provide specific information,  
but the more information you include, the easier it is for 
users to find your video.

Use the “Save changes” button to save the updates 7. 
you’ve made to the video file.

It can take from a couple minutes to an hour for your 8. 
video to upload to YouTube. If you’re receiving an 
error with your Upload, you might want to make sure 
you’re attempting to upload a file that’s recognized by 
YouTube. YouTube accepts video files from most digital 
cameras and camcorders, and cell phones in the .AVI, 
.MOV, .WMV, and .MPG file formats.

After your video is publicly available, copy the Video 9. 
URL (on the right side of the page). You’ll need it to fill 
out the entry form for this competition.

Competition seleCtion AnD prizes
The competition’s submission period runs from June 8 
through August 23. After the closing date—11 p.m. EST 
on August 23, 2009—students from the Frank Lloyd 
Wright School of Architecture will choose 10 finalists to 
be included in the People’s Prize voting, which will run 
from September 7 through October 10. At the same time, 
a panel of experts will convene in New York to review all 
shelter designs and select the winner of the Juried Prize. 
Two prizes—a People’s Prize and a Juried Prize—will be 
awarded. Winners of both prizes will be announced on 
the Guggenheim’s Web site and at the Guggenheim’s 
50th Anniversary Celebration on October 21, 2009 at the 
Guggenheim Museum, New York.

JurY of experts
Aidan Chopra, product evangelist, google sketchup 
Aidan Chopra works at Google as the product evangelist 
for Google SketchUp, a 3-D modeling tool used by 
design professionals, engineers, and 3-D enthusiasts all 
over the world. He is the author of Google SketchUp For 
Dummies, which was published in 2009. Chopra holds an 
undergraduate degree from NSCAD University in Halifax, 
and a Master of Architecture degree from Rice University 
in Houston. At Google, his job is to be an advocate for  
the everyday communication of concepts, ideas, and  
places in 3D.

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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martin Cox, principal, bade stageberg Cox
Martin Cox is a principal of the New York firm Bade 
Stageberg Cox. The work of the practice has been 
widely published, and has won several awards including 
a 2009 New York AIA Honor Award for their proposal 
for the annual MoMA/P.S. 1 Young Architects Program, 
and a 2008 California AIA award for their Art Cave 
project. Previously, from 1996 until 2006, he was a senior 
associate at the firm Steven Holl Architects. Cox teaches 
design studio in the graduate program at Yale School of 
Architecture.

neil m. Denari, principal, neil m. Denari Architects
Neil M. Denari is currently a professor in the Architecture 
and Urban Design Department at UCLA. He is the 
author of two bestselling books, Interrupted Projections 
and Gyroscopic Horizons. In 2002, he was given both the 
Richard Recchia Award and the Samuel F.B. Morse Medal 
for architecture from the National Academy of Design 
in New York for distinguished work in the field. In 2008, 
the American Academy of Arts & Letters awarded him 
the Academy Award for Architecture. Denari received his 
BA from University of Houston and a master’s degree in 
architecture from Harvard University. In 1988 Denari began 
Cor-Tex Architecture in Los Angeles, which later became 
Neil M. Denari Architects (NMDA), Inc.

Cathleen mcguigan, Contributor, newsweek
Cathleen McGuigan is a contributor to Newsweek, where 
she writes about architecture, design and culture. Her 
articles have also appeared in numerous other publications 
including the New York Times Magazine, Smithsonian, 
Architectural Record, and Harper’s Bazaar. A graduate of 
Brown University, McGuigan was a recipient of the Loeb 
Fellowship at the Harvard Graduate School of Design. 
She is an adjunct professor at the Columbia School of 
Journalism, a member of the Forum for Urban Design, and 
serves on the board of the Skyscraper Museum in  
New York.

Victor sidy, Dean of the frank lloyd Wright school of 
Architecture
Victor Sidy received his architectural training from the 
Frank Lloyd Wright School of Architecture after receiving 
the Flinn Foundation Scholarship and Robert C. Byrd 
Scholarship. He has worked with artists, architects, and 
planners in Russia, Germany, the Netherlands, and the 

United States and has taught students from elementary 
school to graduate school in a variety of architecture-
related fields. From 1996 to 1998 Sidy hosted a television 
series on architecture for EMG Satellite Television, and 
in May 1999 was the youngest member of Architecture 
Magazine’s feature “Young Americans.” He was named 
Dean of the Frank Lloyd Wright School of Architecture  
in 2005.

lisa strausfeld, partner, pentagram
Lisa Strausfeld has been a partner in Pentagram’s New York 
office since 2002. She and her team specialize in digital 
information projects that include the design of large-scale 
media installations, signage and exhibitions, software 
prototypes, user interfaces, and Web sites. Strausfeld 
has been a member of The Gallup Organization’s Senior 
Scientist program since 2006, was selected as a “Cutting 
Edge Designers” in 2007 by BusinessWeek, and was named 
a Finalist in the Interaction Design category of the 2009 
National Design Awards. She studied art history and 
computer science at Brown University and earned master’s 
degrees in architecture from Harvard University and in 
media arts and sciences from M.I.T.

David van der leer, Assistant Curator of Architecture 
and Design, solomon r. guggenheim museum
David van der Leer joined the Guggenheim in October 
2008 and is co-curator of the current exhibition Frank 
Lloyd Wright: From Within Outward. Prior to the 
Guggenheim, he held editorial and curatorial positions at 
010 Publishers in Rotterdam; the Office for Metropolitan 
Architecture (OMA), in Rotterdam, under Rem Koolhaas; 
and Steven Holl Architects in New York. Van der Leer 
has lectured internationally on architectural theory and 
is a regular contributor to publications such as Domus, 
Mark, The Architect’s Newspaper, Azure, and PIN-UP. He 
received his master’s in Urban and Architectural Theory 
from the Department of Art & Cultural Sciences at 
Erasmus University Rotterdam, the Netherlands. 

oVerVieW of prizes
people’s prize
Trip for two to New York City (includes airfare and hotel 
accommodations for two nights)

Behind-the-scenes tour of the Guggenheim Museum and 
the Google Offices

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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Free admission to other NYC museums

Google SketchUp Pro license (USD$495 value)

Juried prize
$1000 cash prize

Trip for two to New York City (includes airfare and hotel 
accommodations for two nights)

Behind-the-scenes tour of the Guggenheim Museum and 
the Google Offices

Free admission to other NYC museums

Google SketchUp Pro license (USD$495 value)
Note: In the event that the same shelter design is chosen by those voting  
for the People’s Prize and by the experts determining the winner of the 
Juried Prize, the People’s Prize will be awarded to the entrant who receives 
the second highest number of votes for the People’s Prize.

see official rules (pg. 12) for details.

frequentlY AsKeD questions
general questions about the competition
q: How do i enter?
A: Complete the submission form and enter all required 
information indicated with an asterisk below (unmarked 
items are optional). All images and text submitted as part 
of the entry may be used for marketing and promotional 
purposes and will not be returned. Entries must be 
submitted during the submission period (June 8–August 
23, 2009) to be considered.

first name*
last name*
e-mail address*
City where you reside*
Country where you reside*
Age* (Must be 13 years or older as of June 8, 2009)

shelter title* (Limited to 40 characters)

shelter Description* (Limited to 70 words)

google 3D Warehouse model link* 
Country where your shelter is located*
upload image of your shelter*
upload 2nd image of your shelter

upload 3rd image of your shelter 
upload 4th image of your shelter
Youtube Video url 
Note: All entries must be in English. You must read and accept the official 
rules prior to submitting your form.

q: Why doesn’t my shelter appear on the guggenheim 
Web site after i submit it?
A: It may take up to 72 hours for your shelter to appear 
on the Guggenheim Web site. You will receive an e-mail 
notification on whether your submission has been accepted 
or rejected if it does not meet competition specifications.

q: How does the judging work?
A. There are two competition prizes: a Juried Prize and a 
People’s Prize. Qualified entrants are eligible to win only 
one prize, either the Juried Prize or the People’s Prize.

For the Juried Prize, a panel of independent experts will 
select a Juried Prize winner from all qualified entries.

For the People’s Prize, a panel of students currently enrolled 
at the Frank Lloyd Wright School of Architecture will select 
ten finalists from all qualified entries. The People’s Prize 
winner will then be selected from this pool of finalists by 
public vote via the competition Web site. Voting will be 
open from 9:00 a.m. EST September 7, 2009 through  
11 p.m. EST on October 10, 2009. Visit the  
Jury and Prizes page for more information.

q: What are the judges looking for?
A. Qualified entries will be judged on a variety of qualities, 
including:

The relationship of the shelter to the built or natural 
environment around it. How does the architecture of your 
shelter relate to physical location you have chosen for it? 
How is your shelter placed on the site? In what ways does 
your shelter take into account the site’s weather?

Innovative design. How does your shelter organize space? 
How does the design of your shelter provide space to live 
and work? Both practical and fanciful ideas are welcome. 
The jury will not take into account whether a shelter could 
physically be built in real life.

Thoughtful use of materials. Why did you choose the 
materials that you used? How do the materials enhance the 
design of your shelters?

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/jury-and-prizes 
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Adherence to the project specs. The interior/sheltered space 
can be no larger than 100 square feet, and entire shelter
no taller than 12 feet high. The structure should not include 
water pipes, gas lines, or electrical wiring.

Quality of the SketchUp model. Well-built models that 
visually represent your design ideas will catch the eye of  
the jury.

Your written description of your shelter will help the jury 
(as well as visitors to the site) to understand your thought 
process and your design. Take this opportunity to explain 
your ideas and decisions, so that viewers will know that your 
choices were made purposefully and for specific reasons. 
You also have the ability to upload up to 4 still images and 
1 animation of your shelter. Although only one still image 
is required, the additional views can be helpful in giving a 
sense of the space in and around your shelter.

q: How will the winners be announced?
A: The winners will be announced on the Guggenheim’s 
Web site and at the Guggenheim Museum’s 50th 
Anniversary Celebration on Oct. 21, 2009. Winners will also 
be announced on the same day on the Google SketchUp 
blog, Lat Long, and other official Google blogs.

q. Can i submit more than one shelter?
A: Yes.

q: How old do i have to be to enter?
A: You must be 13 years of age or older on or before  
June 8, 2009.

q: may i work collaboratively with other people?
A: Yes, you may seek assistance from others, but there  
can only be one official entrant and one winner per prize.

q: How many times can i vote for the people’s prize 
winner?
A: You may vote only once.

q: What are the prizes?
A: The Juried Prize winner and one guest will be flown to 
New York City (economy class) for a behind-the-scenes 
tour of the Solomon R. Guggenheim Museum and the 
Google Offices. The Juried Prize also includes two nights 
accommodation for two, complimentary admission to 
selected New York City museums, a Google SketchUp Pro 
license (USD$495 value), and a USD$1000 cash award.

The People’s Prize winner and one guest will be flown to 
New York City (economy class) for a behind-the-scenes 
tour of the Solomon R. Guggenheim Museum and the 
Google Offices. The People’s Prize also includes two nights 
accommodation for two, complimentary admission to 
selected New York City museums and a Google SketchUp 
Pro license (USD$495 value).

q: if i have other questions, who do i ask?
A. Feel free to visit our Design It: Shelter Competition 
Google Group, an online community where you can share 
your experiences with other participants and get answers to 
your questions. If you need additional help, you can e-mail 
us at foundation@guggenheim.org.

questions about the tools
q: Do i need the pro versions of sketchup or earth to 
model for this competition?
A: No. The free versions of Google SketchUp and Google 
Earth will work just fine.

q: What is the difference between sketchup and 
sketchup pro? Will i be able to make a better model if i 
buy the pro version?
A: You don’t need to have the Pro version of SketchUp 
in order to enter this competition. The model-making 
features of both the Free and Pro versions are very similar, 
and both can upload files to the Google 3D Warehouse 
and create models which can be viewed in Google Earth. 
Read this article to learn more about the differences 
between the two versions of SketchUp. 

q: How do i submit my models?
A: Models must be submitted via the submission form. 
Please visit the How to Enter page for competition 
guidelines.

q: my model appears in the wrong city when i place it in 
google earth. How do i fix this?
A: If you create a model without first getting the current 
view from Google Earth and then place your model in 
Google Earth, the model uses the coordinates of the 
default location. Please read this article to find out how to 
resolve this issue.

q: How do i learn to use google sketchup?
A: See the Google SketchUp Tutorial page for instructions 
and resources.  Read this article for a list of ways to get up 
and running quickly. 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://groups.google.com/group/DesignItCompetition?pli=1
http://groups.google.com/group/DesignItCompetition?pli=1
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=36201
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/how-to-enter 
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/sketchup-tutorial
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=36211
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q: is there a list of keyboard command short-cuts for 
sketchup?
A: Yes. Keyboard command short-cuts for SketchUp are 
available as a PDF download on this page. 

q: What are the design constraints for my shelter?
A: You can build your shelter anywhere on Earth: from city 
to desert, hill to valley. You cannot remove any existing 
buildings, but you can add on to existing structures. Keep 
your shelter small—it can be no larger than 100 square feet 
(9.3 square meters), and entire shelter no taller than 12 feet 
(3.6 meters). Your shelter must offer protection from the 
elements and provide a space for one person to study and 
sleep. Keep it simple—no water, gas or electricity allowed.

q: What types of file type and size are required for the 
still images?
A: JPEGs at a minimum of 235 pixels wide but no larger 
than 720 pixels wide at 72 dpi.

q: if i build a physical shelter in real life, can i submit 
photos of that in addition to the sketchup model?
A: Yes, you may use one (or more) of the images in the 
submission form to include shots of the physical structure.

q: Do i have to use google sketchup to model my 
shelter?
A: You can use any 3-D modeling software you prefer to 
design your shelter, but you must upload your model to 
the Google 3D Warehouse, and this can only be done 
from inside Google SketchUp. If you decide to use another 
tool to do your modeling, know that SketchUp imports 
3-D model data in DXF, DWG and 3DS format. Read 
this article for more information about importing data into 
SketchUp.

q: i forgot to tell sketchup where to place my model on 
google earth. now that my model is complete, how can 
i have it appear in the location on google earth?
A: You can import a Google Earth terrain “snapshot” into 
your SketchUp file at any time, then position your model 
in the right place. Doing so gives your model a geographic 
location. Read this article for more information. 

q: Can i make changes to my model after i’ve 
submitted it?
A: No, you may not make changes to your model after 
submitting it.

q: i was able to make some changes to my model in the 
google sketchup 3D Warehouse after i submitted, but 
i do not see the updated changes on the guggenheim 
competition site.
A: Once you submitted your model to the competition, 
you are no longer permitted to make changes.

offiCiAl rules
No purchase necessary to enter or win.

The following are the official rules for the Guggenheim 
Museum and Google® SketchUp Design It Shelter 
Competition (the “Competition”):

Organizer: The Competition is organized by The 1. 
Solomon R. Guggenheim Foundation, located at 
345 Hudson Street, Floor 12, New York, NY 10013 
(“Organizer”).

Binding Agreement: In order to enter the Competition, 2. 
each entrant (“you”) must agree to these Official Rules, 
which consist of the terms and conditions on this page 
and the Entry Form made available on the Guggenheim 
Foundation Web site at http://www. guggenheim.org/
new-york/education/sackler-center/design-it-shelter/
official-rules. If you are a minor, you must obtain the 
permission of a parent and/or legal guardian and your 
parent and/or legal guardian must also agree to these 
Rules on their and your behalf before you can enter 
this Competition. Therefore, please read these Rules 
carefully prior to entry to ensure that you understand 
and agree. You agree that submission of an entry in 
the Competition constitutes agreement to these Rules.  
You may not submit an entry to the Competition and 
you are not eligible to receive the prizes described in 
these Rules unless you agree to these Rules.  These 
Rules form a binding legal agreement between you and 
Organizer with respect to the Competition. You must 
have access to the Internet and a valid e-mail address in 
order to enter the Competition.

Eligibility: The Competition is open to entrants 13 3. 
years of age and older. Anyone between the ages of 13 
to 17 must obtain the permission of a  parent or legal 
guardian prior to entering, and the parent or guardian 
must  consent to be bound—on their child’s and their 
own behalf—to these Official Rules. The Competition 
is subject to all applicable federal, state and local laws 
and regulations, and is void where prohibited by law. 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=116693 
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=36217 
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=36245 
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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Employees of Organizer, employees of Google Inc., 
and students and employees of the Frank Lloyd Wright 
School of Architecture—as well as their immediate 
families (spouse, parent, sibling, child, and spouse of any 
of the foregoing) and those living in their immediate 
households, whether or not related—are not eligible to 
enter the Competition or to win a prize. 

Entry Period: The Competition entry period begins 4. 
June 8, 2009 at 9 am EST and ends on August 23, 2009 
at 5 pm EST (the “Entry Period”).

Competition Details: Organizer invites designers from 5. 
around the world—both amateur and professional—to 
submit their 3D designs for an original shelter that 
responds to a unique location anywhere on Earth.  
Entrants share ideas on the Guggenheim Foundation’s 
Web site by modeling the shelter using Google 
SketchUp or another 3D modeling program, and 
placing the model on a specific location in Google Earth 
and in the Google 3D Warehouse. Location:  
You can build your shelter anywhere on earth: from city, 
to desert, from the hills to a valley. You cannot remove 
any existing buildings, but you can add on to existing 
structures. Size: Keep your shelter small—no larger than 
100 square feet, and entire shelter no taller than 12 feet. 
Amenities: Your shelter must offer protection from the 
elements and provide a space for one person to study and 
sleep. Keep it simple—no water, gas or electricity allowed.

When designing a shelter, you are encouraged to 
consider Frank Lloyd Wright’s interest in the connection 
between architecture and location, i.e., how does 
your shelter respond to the specific natural and built 
environments that surround it?

How to Enter: Complete the entry form and enter 6. 
all required information as indicated with an asterisk 
below (unmarked items are optional). Entries must be 
submitted here: http://www.guggenheim.org/new-york/
education/sackler-center/design-it-shelter/designit-
competition-entry-form. All images and text submitted 
as part of the entry may be used by Organizer for 
marketing and promotional purposes and will not be 
returned. Entries must be submitted during the Entry 
Period to be considered.

first name*
last name*
e-mail address*
City where you reside*
Country where you reside*
Age* (Must be 13 years or older as of June 8, 2009)
shelter title* (Limited to 40 characters)
shelter Description* (Limited to 70 words)
google 3D Warehouse model link* 
Country where your shelter is located*
upload image of your shelter* 
upload 3rd image of your shelter (same as above)
upload 4th image of your shelter (same as above)
Youtube Video url 
All entries must be in English. In order to be eligible for 
a prize, your entry must be uploaded into the Google 
3D Warehouse. To upload your model to the 3D 
Warehouse you must create a Google Account. To sign 
up for a Google Account, visit http://www.google.com/
accounts. Organizer accepts no responsibility for lost 
or delayed submissions. The submission of an entry is 
your sole responsibility. Automated entries (including, 
but not limited to, entries submitted using any bot, 
script, macro or contest service), copies, third-party 
entries, facsimiles and/or mechanical reproductions are 
not permitted and will be disqualified. Each entrant may 
submit as many entries as they wish, one model shelter 
per entry.
Ownership Rights in Submissions; Originality; 7. 
License Grant: By submitting a shelter design in the 
Competition (the “Submission”), you represent and 
warrant that (1) the Submission (which includes the 
models, images, video, and text submitted with the 
shelter design) is your original work and you are the 
sole and exclusive owner and rights holder of the 
Submission; (2) you have not entered into or become 
subject to any contract, agreement or understanding 
that conflicts with your ability to enter into this legally 
binding agreement and convey the rights set forth 
herein; and (3) the Submission shall not infringe 
any third party proprietary, intellectual property or 
other rights, including, without limitation, copyright, 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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trademark, patent, trade secret or confidentiality 
obligation. Your entry must not have won a prize in any 
other competition or have been previously published  
or sold.

By submitting a Submission, you grant to Organizer 
and Google Inc., their affiliates, and their respective 
successors and assigns, a non-exclusive, unlimited, 
worldwide, perpetual, royalty-free license to publish, 
reproduce, display, transmit, distribute, adapt, make 
derivative works of, and otherwise use your Submission, 
in any media now known or not yet existing, including 
but not limited to the Guggenheim.org Web site and 
other Guggenheim- and Google-sponsored web pages 
for any and all purposes. You hereby acknowledge that 
you shall not be entitled to any compensation for any 
use of your Submission by Organizer.

Winner Selection: There are two Competition prizes: a 8. 
Juried Prize and a People’s Prize. Each qualified entrant 
is only eligible to win either the Juried Prize or the 
People’s Prize

JURIED PRIZE: A panel of independent experts invited 
by Organizer will select a Juried Prize winner from all 
qualified entries

PEOPLE’S PRIZE: A panel of students currently 
enrolled at the Frank Lloyd Wright School of 
Architecture will select ten finalists for the People’s Prize 
from all qualified entries.  The winner will be selected by 
public vote via the Web site.  Voting will be open from 
9:00 a.m. EST September 7, 2009 through 11 p.m. EST 
on October 10, 2009

Qualified entries will be judged on a variety of qualities, 
including:

The relationship of the shelter to the built or natural 
environment around it. How does the architecture of 
your shelter relate to physical location you have chosen 
for it? How is your shelter placed on the site? In what 
ways does your shelter take into account the site’s 
weather?

Innovative design. How does your shelter organize 
space? How does the design of your shelter provide 
space to live and work? Both practical and fanciful ideas 
are welcome. The jury will not take into account whether 
a shelter could physically be built in real life. 

Thoughtful use of materials. Why did you choose the 
materials that you used? How do the materials enhance 
the design of your shelters.

Adherence to the project specs. Your shelter can be no 
larger than 100 square feet, and entire shelter no taller than
12 feet high. The structure should not include water pipes, 
gas lines, or electrical wiring.

Quality of the SketchUp model. Well-built models that 
visually represent your design ideas will catch the eye of  
the jury.

Your written description of your shelter will help the 
jury (as well as visitors to the Competition Web site) 
understand your thought process and your design. Take 
this opportunity to explain your ideas and decisions, 
so that viewers will know that your choices were made 
purposefully and for specific reasons. You also have the 
ability to upload up to four (4) still images and one (1) 
animation of your shelter. Although only one (1) still 
image is required, the additional views may be helpful in 
giving a sense of the space in and around your shelter.

The decisions of Organizer and the judges in 
selecting the winners and in all matters relating to 
the Competition are final and binding. The winning 
shelters and identity of the winners will be announced 
on Guggenheim.org and at the Guggenheim Museum’s 
50th anniversary celebration on October 21, 2009. 
The winners will be notified by email and in writing by 
certified mail no later than October 15, 2009.

Prizes:9. 

JURIED PRIZE: On a date to be determined by 
Organizer, the Juried Prize winner and one guest 
will be flown to New York City (economy class) for a 
behind-the-scenes tour of the Solomon R. Guggenheim 
Museum and the Google Inc. offices. The Juried Prize 
also includes two nights’ accommodation for two, 
complimentary admission for two to selected New York 
City museums, Google SketchUp Pro license (USD 
$495 value), and a USD $1000 cash award.

PEOPLE’S PRIZE: On a date to be determined by 
Organizer, the People’s Prize winner and one guest 
will be flown to New York City (economy class) for a 
behind-the-scenes tour of the Solomon R. Guggenheim 
Museum and the Google Inc. offices. The People’s 
Prize also includes two nights’ accommodation for two, 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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complimentary admission for two to selected New York 
City museums and a Google SketchUp Pro license 
(USD $495 value.

If the winner of either the People’s Prize or the Juried 
Prize chooses not to accept the prize, an alternate 
winner will be chosen. All federal, state, and local taxes 
on the value of the prize are the sole responsibility 
of the winner. A 1099 tax statement will be filed with 
the IRS for each winner and each winner may be 
required to sign and return to Organizer a W-9 form, 
an Affidavit of Eligibility, a Liability/Publicity Release, 
and/or a Parental/Guardian Consent Form. Failure 
to do so within the applicable time period may result 
in disqualification and forfeiture of his or her prize. 
Return of any prize/prize notification may result in 
disqualification and selection of an alternate winner.  
Any potential winner who cannot be contacted within 
fifteen (15) days of attempted first notification may 
result in disqualification and forfeiture of his or her prize.

All minors traveling to New York City must be 
accompanied by one parent or legal guardian. 
Airfare and hotel accommodations will be arranged 
at Organizer’s discretion. Winners are responsible for 
transport from their home to and from their airport 
and any other incidentals or expenses. There is no cash 
alternative and the prizes must be taken as offered. 

Right to Use Name, Likeness, and Other Identifying 10. 
Information: By submitting a Submission, you grant to 
Organizer and Google Inc., their affiliates and their 
respective successors and assigns, the right, except 
where prohibited by law, to use your name, likeness, city 
and state, biographical information, and Submission 
materials for all purposes, including, but not limited 
to, press and media communications, without further 
compensation to you.  You also agree to participate 
in any media or promotional activity regarding the 
Competition. If you are a winner, you agree that 
Organizer and Google Inc. may use your name and 
likeness to administer and promote the Competition 
and to conduct media interviews and promotional 
events, and you hereby explicitly waive your rights of 
privacy and publicity under applicable law.

Privacy:  By participating in this Competition, you agree 11. 
that Organizer can collect your personal information, 
and that if Organizer cannot collect the required 
data, you may not be eligible to participate in the 
Competition.  Any personal information collected 
during the course of the Competition by Organizer will 
only be used for administering this Competition and 
for other purposes as outlined in these Official Rules, 
and will be subject to the Organizer’s and Google Inc.’s 
respective Privacy Policies located at  
http://www.guggenheim.org/privacy-policy/ and  
http://www.google.com/intl/en/privacy.html. You will 
have the right to access, review, rectify or cancel any 
personal data held by Organizer or Google Inc. by 
writing to Organizer or Google Inc. at the addresses 
specified in the above-mentioned Web site address 
listed above. If you do not want your information used in 
this manner, do not enter this Competition.

General Conditions: This Competition is governed 12. 
by the laws of the State of New York, United States.  
All federal, state and local laws and regulations apply.  
By participating in this Competition, you agree to be 
bound by the terms of these Official Rules, which will 
be posted on the Competition Web site at: http://
www.guggenheim.org/new-york/education/sackler-
center/design-it-shelter/official-rules throughout the 
Entry Period, and by the decisions of Organizer and 
the judges, which are final and binding on all matters 
pertaining to this Competition.

By participating in this Competition, you agree to be 
bound by the terms and conditions of the  
Guggenheim Foundation and Google, including any 
specific terms of use that govern Google SketchUp, 
Google 3D Warehouse and Google Earth, which are 
Google products.  Use of any Google products and 
related programs are neither hosted, managed nor 
operated by the Guggenheim Foundation.

Organizer reserves the right, in its sole discretion, to 
disqualify any entrant found to be (1) tampering or 
attempting to tamper with the entry process or the 
operation of the Competition; (2) violating the Official 
Rules; (3) violating the terms of service, conditions 
of use or general rules or guidelines of any Organizer 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/terms-conditions/
http://www.google.com/accounts/TOS
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or Google Inc. property or service; or (4) acting in 
an unsportsmanlike or disruptive manner, or with the 
intent to annoy, abuse, threaten or harass any other 
person.  Any false information provided within the 
context of the Competition by any entrant concerning 
identity, postal address, or ownership of rights in the 
Submission, and/or non-compliance with Official Rules 
may result in the immediate elimination of the entrant 
from the Competition. Organizer further reserves 
the right to disqualify any entry that it believes, in its 
sole discretion, infringes or violates the rights of any 
third party or otherwise does not comply with the 
Official Rules.  CAUTION:  ANY ATTEMPT BY AN 
ENTRANT OR ANY OTHER INDIVIDUAL TO 
DELIBERATELY DAMAGE ANY WEB SITE OR 
UNDERMINE THE LEGITIMATE OPERATION OF 
THE COMPETITION MAY BE A VIOLATION OF 
CRIMINAL AND CIVIL LAWS.  SHOULD SUCH 
AN ATTEMPT BE MADE, ORGANIZER RESERVES 
THE RIGHT TO SEEK DAMAGES FROM ANY 
SUCH PERSON TO THE FULLEST EXTENT 
PERMITTED BY LAW.

Organizer, its affiliates, and their respective officers, 
directors, trustees, employees, agents, successors and 
assigns (collectively, the “Released Parties”) are not 
responsible for electronic transmission errors resulting 
in omission, interruption, deletion, defect or delay in 
operations or transmission.  Released Parties are not 
responsible for theft or destruction or unauthorized 
access to or alterations of Competition materials, or for 
technical, network, telephone equipment, electronic, 
computer, hardware or software malfunctions or 
limitations of any kind.  Released Parties are not 
responsible for inaccurate transmissions of or failure to 
display Competition materials as a result of technical 
problems or traffic congestion on the Internet or at any 
website or any combination thereof.  If for any reason 
the Internet portion of the Competition is not capable 
of running as planned, including infection by computer 
virus, bugs, tampering, unauthorized intervention, fraud, 
technical failures, or any other causes which corrupt or 
affect the administration, security, fairness, integrity, or 
proper conduct of this Competition, Released Parties 
reserve the right, in their sole discretion, to cancel, 
terminate, modify or suspend the Competition.

No Recourse to Judicial or Other Procedures: To the 13. 
extent permitted by law, the rights to litigate, to seek 
injunctive relief or to any other recourse to judicial 
or any other procedure in case of disputes or claims 
resulting from or in connection with this Competition 
are hereby excluded, and you expressly waive any and 
all such rights.

LIMITATIONS OF LIABILITY; INDEMNIFICATION: 14. 
TO THE MAXIMUM EXTENT PERMITTED BY 
LAW, YOU INDEMNIFY AND HOLD HARMLESS 
THE RELEASED PARTIES FROM AND AGAINST 
ANY LIABILITY, CLAIMS, DEMANDS, LOSSES, 
DAMAGES, COSTS AND EXPENSES RESULTING 
FROM, RELATED OR INCIDENTAL TO (1) ANY 
ACT, OMISSION, DEFAULT OR BREACH BY 
YOU OF THE RULES OR ANY WARRANTY 
BY YOU SET FORTH HEREIN; AND (2) YOUR 
PARTICIPATION IN THE COMPETITION AND/
OR YOUR USE OR ACCEPTANCE OF ANY PRIZE 
WON.

Severability: If any provision(s) of these Official Rules 15. 
are held to be invalid or unenforceable, all remaining 
provisions hereof will remain in full force and effect.

Entire Agreement: This binding agreement is the entire 16. 
understanding between you and Organizer concerning 
the subject matter addressed herein and supersedes 
and replaces any previous understandings between the 
parties concerning the subject matter addressed in this 
binding agreement. 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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Antecedentes  
 
El primer día que llegué a la Exhacienda del Chorrillo para unirme al 
claustro de profesores del Centro de Extensión Taxco de la Escuela 
Nacional de Artes Plásticas (CET), me tropecé en las áreas verdes, 
que actualmente están reducidas canales de transito peatonal, con la 
ruina de lo que fue un balón de fútbol, lo cual de momento me pareció 
extraño, pero cuando me encontré con la toponimia de Taxco comenzó a 
tener sentido. La toponimia de este lugar se bifurca en la antigüedad 
mexicana y la época novohispana, de donde recoge el nombre de uno de 
sus más ilustres hijos, se trata del novelista Juan Ruiz de Alarcón, 
nacido en 1581 en esta localidad1. Y de la antigüedad mesoamericana 
se retoma el nombre de Taxco que proviene del vocablo náhuatl 
tlachco2 que significa lugar donde se juega pelota3, es una palabra 
compuesta por: tlacht que se traduce como juego de pelota y el 
locativo -co que significa en o el lugar4. 
    

 
 

Tlacht / Juego de pelota  
Fragmento de la página 42 del Códice Borgia 

 
 

 Sin embargo en la ciudad de Taxco no encontramos un campo del 
juego de pelota antiguo, tampoco algún elemento tridimensional que 
pueda atizar el imaginario colectivo y la identidad precolombina 
de sus habitantes en torno a su toponimia, solo encontramos un 
resabio en el logotipo utilizado por las administraciones 
municipales, reproducido innumerables veces en el mobiliario 
urbano y en algunos mosaicos de las calles a manera de placa 
conmemorativa, perdiendo su simbolismo y reduciéndolo a un signo 
visual de consumo. Y me pregunto, ¿Dónde están las pelotas? del 
lugar donde se juega a la pelota.  
                            
1 Wikipedia: la enciclopedia libre. (DE, 28 de septiembre, 2009: 
http://es.wikipedia.org/wiki/Juan_Ruiz_de_Alarcón) 
2 Wikipedia: la enciclopedia libre. (DE, 28 de septiembre, 2009: 
http://es.wikipedia.org/wiki/Taxco_de_Alarcón#Toponimia) 
3 Rodríguez Villegas, Manuel. AULEX Diccionario Nahuatl – Español en 
línea. (DE, 28 de septiembre, 2009: http://aulex.org/nah-es/) 
4 Página del Gobierno del Estado de Guerrero. (DE, 28 de septiembre, 2009: 
http://www.guerrero.gob.mx/?P=taxco) 



Justificación 
 
Hoy día las pelotas de tlachco se encuentran en los innumerables 
campos de fútbol en la ciudad y sus alrededores, es el balón un 
elemento plástico alrededor del cual se generan fuertes lazos de 
identidad social. Pero ¿qué encierra simbólicamente un balón de 
fútbol en la vida contemporánea?, algunos dicen que “el mundo gira 
alrededor de un balón”, y otros más poéticos como Juan Villoro 
dicen, es “el epicentro de sinergias colectivas en ocasiones 
inexplicables… argamasa cosmética que fija los ladrillos apilados, 
uno sobre otro, del lazo social contemporáneo”5, por ello tomamos 
el balón de fútbol como origen y pretexto de este proyecto, 
titulado tlachtli que significa pelota en náhuatl. 

 
 Ahora bien, el balón nos permitirá un acercamiento emotivo y 
amable con los ciudadanos, lo cual es fundamental para poder 
desarrollar un proyecto de arte público en una ciudad de poderosos 
hitos urbanos6, que la han hecho merecedora a formar parte de los 
Pueblos Mágicos de México7, pero mas allá de los múltiples 
monumentos con que cuenta esta localidad la imagen urbana es una 
construcción ciudadana, donde el estilo vernáculo se regodea en 
las fachadas de cada casa, dando una imagen sui generis de pueblo 
y ciudad simultáneamente, de esta relación dialéctica entre el 
                            
5 Villoro, Juan. Dios es redondo. Anagrama, Barcelona, 2006.  
6 El concepto de hito urbano es tomado del libro: Lynch, Kevin. La imagen 
de la ciudad. Gustavo Gili, Barcelona: 2000, y como ejemplos de estos 
están La Catedral de Santa Prisca y San Sebastián, los encruzados, el 
Cristo, la Ex-hacienda del Chorrillo, la Garita, entre otras.   
7 http://www.pueblomagicodemexico.com.mx/sec/taxco/taxco.php?opc=1 
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 Otra de las razones por las cuales se propone este lugar como 
emplazamiento de la obra, es sumarse al proyecto conjunto que 
mantienen el Gobierno del Estado de Guerrero y la UNAM a través 
del CET, que tiene como uno de sus objetivos ser “un espacio 
crítico que permita llevar a cabo… la experimentación plástica… y 
favorecer la producción de arte contemporáneo fomentando el 
desarrollo cultural”12 de la sociedad Taxqueña, siendo una de las 
tipologías artísticas contemporáneas el arte público, este 
proyecto se fundamenta en la participación ciudadana dentro de los 
procesos de creación, difusión y consumo13 del hecho artístico, 
para lo cual se instrumentará y ejecutarán diferentes dinámicas 
donde se involucre a la población taxqueña en esta obra. 
 

 
 

Tlachtli  
Fotomontaje del proyecto (vista desde el interior) 

 
 
 Finalmente, al encontrarse situado en una escuela, le daremos 
una función a nuestra pelota, será utilizada como refugio para el 
estudio y contemplación, a partir de la cual se podrá percibir el 
entorno verde mediante sus doce ventanas pentagonales, dos con 
ventilación, y un acceso principal por el cual el estudiante podrá 
ingresar a esta geodesia, diseñada para propiciar la concentración 
y estimular la imaginación del estudiante y visitantes a la 
hacienda.       

                            
12 Página oficial del Centro de Extensión Taxco, (DE, 29 de septiembre, 
2009: http://www.enap.taxco.unam.mx/QUIENES.htm) 
13 Para enmarcar teóricamente el concepto de arte público que utilizo 
visite la pagina: http://www.ub.edu/escult/index.htm.  



 
 
 

Objetivo general 
 

• Activar culturalmente el andador norte de las instalaciones 
del CET en la Exhacienda del Chorrillo en Taxco de Alarcón, 
Guerrero, mediante la instalación de un refugio para el 
estudio y la contemplación, donde se involucre a los 
ciudadanos táxqueños a través de su participación, con la 
intención de crear sentimientos de pertenencia y defensa de 
este lugar, a partir de procesos de  simbolización social del 
espacio14. 
 
 

Objetivos específicos 
 

• Regenerar urbanamente el andador norte del CET que 
actualmente es consumido por los estudiantes y visitantes 
como canal de flujo impersonales15 y no como espacio público. 

 
• Fomentar la apropiación ciudadana de este lugar a través de 

la participación ciudadana en la creación, difusión y consumo 
de esta obra. 

 
• Renovar artísticamente la técnica de cimbrado como símbolo 

constructivo de una ciudad vernácula como Taxco de Alarcón, donde 
la conciencia de conservación arquitectónica destaca, en un mundo 
donde los materiales prefabricados y las técnicas de la información 
dominan los procesos artísticos y constructivos de hoy. 

                            
14 Pol Urrutia, Enric. Cognición, representación y apropiación del 
espacio. Universidad de Barcelona, Barcelona: 1996. 
15 Auge, Marc. Los no lugares: espacios del anonimato. Gredisa, Barcelona: 1993.   



Metas 
 

• Instalar un refugio de estudio y contemplación en el Centro 
de Extensión Taxco en la Exhacienda del Chorrillo en Taxco de 
Alarcón. 

 
• Lograr una participación ciudadana mayor de cien personas. 

 
• Realizar documental impreso, objetual y videograbado del 

proceso creativo para ser exhibido en el Museo Spratling de 
la ciudad de Taxco y en línea16.   

 
 
Resultados o productos finales 
 

• Un refugio de estudio y contemplación en el CET. 
 

• Dos exposiciones documentales, una presencial y otra virtual. 
 
 
Cronograma de actividades 
 
Nº Actividad Ene Feb Mar Abr May Jun Jul Ago Sep Oct Nov Dic

1 
Elaboración de 
material 
didáctico 

            

2 
Difusión de 
participación 
ciudadana 

            

3 
Recolección de 
material donado 
por la ciudadanía 

            

4 Construcción del 
refugio in situ 

            

5 Documentación del 
proceso creativo 

            

6 Inauguración del 
refugio 

            

7 Edición de la 
documentación 

            

8 

Inauguración de 
la exposición del 
proyecto en el 
Museo y en línea 

            

 
 
Estimación trimestral de grado de avance 
 

A
v
a
n
c
e
 Primer trimestre Segundo trimestre Tercer trimestre Cuarto trimestre
25%    
 50%   
  75%  
   100% 

 

                            
16 Subir este video documental a http://www.youtube.com/  
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